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Abstract

Ivy geranium (Pelargonium peltatum L’Herr ex. Ait.) and tomato (Solanum lycopersicum
L.) are two economically important greenhouse crops known to be affected by non-pathogenic
lesions on leaf tissues. These physiological disorders are often termed edema (oedema) or
intumescences, but several other names have been used including enations, non-pathogenic galls
or tumors, and neoplasms. These lesions, characterized by small protrusions on leaf tissues that
become necrotic over time, are considered to be the result of environmental factors. Our research
focused on determining what environmental factors affect these disorders on ivy geranium and
tomato.

The physiological disorder of ivy geranium is thought to be the result of water uptake
exceeding transpiration, resulting in a build-up of water and solutes in leaf tissue that results in
the blister-like protrusions in the epidermal layer. Current convention suggests that susceptible
plants be grown in an environment that promotes transpiration with low humidity and infrequent
watering. Over four experiments, we evaluated the effects of four root medium water contents,
five rates of supplemental calcium application and two vapor pressure deficit (VPD)
environments on three cultivars of ivy geranium. Our results indicate that high root medium
water contents do not increase the incidence of edema on ivy geranium, but increase overall plant
growth. Supplemental calcium had no affect on edema or growth, while our VVPD results were
inconclusive. These results suggest that current convention regarding cultural practices that abate
the disorder be revisited.

In tomato var. hirsutum ‘Maxifort’, the physiological disorder is characterized by
individual epidermal cells swelling, which is unlike the disorder in ivy geranium where solutes
build up across a group of epidermal cells. The environmental factors we focused on were two
root medium water contents and supplemental UVB light. Our results suggest that root medium
water content may play a role in development of tomato intumescences based on visual

observation, and UVB light supplementation helps prevent the lesions from forming.
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CHAPTER 1 - Literature Review

Edema and intumescence development are disorders of greenhouse grown crops,
characterized by non-pathogenic bumps, galls, or blisters on plant tissues. Often, the terms
edema (oedema) and intumescences are used interchangeably with several other terms, which
include enations, genetic tumors, neoplasms, and non-pathogenic galls. While these terms are
used interchangeably, the term edema is most used in ivy geranium (Pelargonium peltatum
L’Herr ex. Ait.), while in tomato (Solanum lycopersicum L.) the most common term used is
intumescences.

Research by previous investigators has suggested several environmental that contribute to
these disorders. Pinkard et al. (2006) provide an extensive review of economically important
plant species known to develop intumescences as well as their probable triggers, which include
mechanical or chemical injury, nutrient status, hormones, genetics, insect and fungal injury, air
quality, light quality and availability temperature, excess water and unknown factors. This
literature review will discuss the environmental conditions that have been associated with edema
and intumescence development in relation to the ivy geranium and tomato experiments presented

in this thesis.

vy Geranium

Edema is most commonly associated in the horticulture industry with geranium
(Pelargonium) species. lvy geranium, a susceptible ornamental crop, is native to costal South
Africa, where temperatures tend to be mild and salt levels in the growing environment may be on
the high side. These environmental conditions have likely led to the morphology of these plants
having thick, waxy cuticles, which aid in water retention. In ivy geranium, epidermal cells are
stretched over an area in which solutes have built up, much like a blister. While mild symptoms
are considered acceptable, moderate to severe symptoms compromise the aesthetics of the plant.
This results in decreased sales of affected plants and economic losses (Balge et al. 1969).

The first known mention of edema was in 1905, when Dale (1905) suggested
environmental conditions as a trigger of edema on Hibiscus vitifolius Linn., as opposed to
pathogens which at the time were thought to be the cause. In her study, moist air was shown to

be a cause of this disorder, while dry air and submergence into water were not.
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Later studies focused on other environmental causes of edema. The primary focus was on
root medium water content and relative humidity. Balge et al. (1969) found that zonal geraniums
(Pelargonium hortorum Ait.) grown in warm, moist soil were more prone to the occurrence of
edema, while geraniums grown in a soil with a water content substantially below container
capacity had fewer edemata.

Metwally et al. (1970a) examined the role of root medium water content further on zonal
geranium. Watering frequencies, supplemental fertilization, media characteristics, and light
intensities were studied. They found that the environmental factors restricting transpiration led to
an increased susceptibility in edema development. Plants grown in an environment with high air
moisture, high soil water contents, low light intensities, or combinations of these factors had
increased edema injury.

A second study by Metwally et al. (1970b) looked at anatomical differences between
zonal geraniums grown with different root medium water contents. Geraniums grown in a high
moisture regime were found to have larger xylem elements and smaller phloem elements, as well
as a larger overall cell size, compared to plants grown under drought stress. They suggest that
these anatomical changes caused increased water movement and decreased movement of
photosynthates within the plant, resulting in abundant water levels in the plant forming edemata.

To elucidate a possible mechanism behind edema formation, Metwally et al. (1971)
researched the formation of stomata on zonal geraniums grown under different soil moisture
regimes. Cultivar and soil moisture content played a role in number of stomata, and the number
of stomata played a role in edemata formation. Higher soil moisture contents led to more stomata
per area in young tissues than those grown in a drier environment. However, higher soil moisture
contents also lead to thinner epidermal cell walls causing a possible trade-off between growing
geraniums wet versus dry in terms of edemata formation. They also found a relationship between
cultivars and susceptibility, suggesting a genetic component to this disorder.

Jonas (2000) contradicts the findings by Metwally et al. (1970a, 1970b, 1971) that
suggest high root medium water contents are the culprit in edema formation. In her thesis, Jonas
found higher root medium water contents did not increase the incidence of edema in ivy
geranium. Further, she found that plants receiving the least frequent irrigation resulted in the
highest levels of edema development, concluding that large fluctuations in root medium water
may play a stronger role than having a high root medium water content overall.
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Other than the Jonas thesis, only one paper has been published on edema development on
ivy geranium (Pelargonium peltatum L’Hér. ex Ait). Rangarajan and Tibbitts (1994) studied the
effect of far-red radiation (700-800 nm) and that plants were exposed to this range of light
wavelengths, plants did not develop edema. Morrow and Tibbitts (1988) found a possible link to
intumescence development in tomato (Solanum lycopersicum var. hirsutum L. ‘Oxheart’.), in
which far-red radiation prevented its occurrence and suggested a possible relation to
phytochrome. It was thought at the time that intumescence development and edema were the
same disorder, so this study was repeated on ivy geraniums. However, far-red radiation had no
effect on prevention of edema in ivy geranium in their study.

The findings, predominately by Metwally et al. (1970a, 1970b, 1971) led to the
recommendation from several sources, ranging from textbooks to extension publications, for
commercial growers to grow susceptible species in as dry an environment as possible without
stressing the plant and keeping pest feeding at a minimum. Feeding from insects such as thrips
(Frankliniella occidentalis (Pergande) Thysanoptera: Thripidae) and spider mite (Tetranychus
urticae (Koch) Arachnida: Acari: Tetranychidae) can cause edema-like symptoms (Burns, 2002).
Suggestions included maintaining low humidity and a low root medium moisture content;
watering during morning hours to provide sufficient time for crops to transpire excess water
(Anonymous 10/1999a; Anonymous 10/1999b; Anonymous 2001; Dole and Wilkins, 1999;
Dudek, 2004; Lemon, 1996; Micheal, 1996; Moorman, 1993; Ogelvee, 2003; Pataky, 1998;
Wiles, 1997); and providing supplemental calcium to strengthen cell walls (Micheal, 1996).
Despite these studies, the factors that contribute edema are still not well understood. Further
research should be undertaken to determine what environmental and genetic factors cause this

disorder so economic losses in the future can be prevented.

Tomato
Intumescences, like edema, are a result of a physiological disorder. In the case of
intumescences, several individual cells swell in a given area, opposed to edema where several
epidermal cells are stretched over what appears to be a pocket of water or solutes forming a
single, blister-like edemata. Intumescences have been found to primarily affect solanaceous
crops grown in controlled environments. However, a few other genera (Populus, Hibiscus,

Eucalyptus, Ipomoea, Cuphea) include certain species known to exhibit intumescence-like
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development. Further, intumescence development is highly dependent on cultivar, as Jarwoski et
al. (1988) found on Cuphea species, suggesting a genetic component.

As with edema, while mild symptoms of intumescence development may be tolerated,
moderate to severe symptoms, including leaf chlorosis, leaf necrosis, and leaf drop, are not
acceptable. Chlorosis and necrosis, along with the finding that intumescence development lowers
the number of chloroplasts in palisade cells (Eliza and Dobrenz, 1971), may cause plants to grow
slowly and to have lower yields than unaffected plants. In addition, plants are severely affected
aesthetically, resulting in economic loss in plant sales to consumers.

The exact environmental triggers of intumescence development are unknown. Previous
authors have suggested many possible factors that can lead to the development of intumescences.
La Rue (1933) noted that intumescences on Populus species were usually the result of excess
moisture in the air or on a leaf surface. In his study, intumescences were readily produced in
artificial environments where humidity and moisture were high and they were only found in the
field on leaves that had not yet unfurled completely and were not exposed to the drier air
conditions. Eliza and Dobrenz (1971) observed that “oedema” on eggplant (Solanum melongena
L.) was induced in hot, humid environments within a plastic greenhouse. Their anatomical study
indicated lesions were caused by hypertrophy (cellular swelling) of palisade cells, which then
ruptured the epidermal layer. Given their description of the disorder and the anatomical analysis,
we believe they were actually studying intumescence development. Pinkard et al. (2006) found
that in eucalyptus (Eucalyptus nitens Libill. and Eucalyptus globulus Deane and Maiden)
intumescence growth was actually the formation of lenticel-like structures on plant leaves as a
result of high relative humidity, which is a way to facilitate gas exchange.

Air pollution containing ethylene was a probable cause in the development of enations on
potatoes (Solanum tuberosum L. ‘Russet Burbank”) grown in a growth chamber according to
Kirkham and Keeney (1974). Petitte and Ormrod (1986) also found that air contaminants SO,
and NO, had an effect on intumescence development on potato, as well as propagation method.
In this case, potatoes (‘Russet Burbank,” ‘Norchip,” and ‘Kennebec’) propagated from a high
carbohydrate source (tuber) generated more intumescences than potatoes propagated via stem
cutting. However, Lang and Tibbitts (1983) found air pollution to be an inconclusive cause on

tomato plants (Solanum lycopersicum var. esculentum L. ‘Oxheart’).



Also in the Lang and Tibbitts (1983) paper, relative humidity and radiance levels did not
have an effect on intumescence development, but temperature and ultraviolet wavelengths did.
Their finding that high temperatures (30°C) resulted in lessened occurrence of intumescences is
contrary to Eliza and Dobrenz (1971) who suggested high temperatures resulted in worse
symptoms. Lang et al. (1983) performed an anatomical study and found results for tomato to be
similar to those of Eliza and Dobrenz (1971) for eggplant. That is, the palisade cells were
hypertrophic, swelling to almost double in size, and they ruptured through the leaf epidermis. In
sweet potato (Ipomoea batatas L. Lam), a different anatomy of the disorder was described by
Wetzstein and Frett (1984), where both hypertrophy (cell swelling) and hyperplasia (cell
proliferation) were evident within mesophyll cells. Hyperplasia has not been reported in any
other paper discussing anatomy of intumescences or edema.

Certain wavelengths of light have been shown to cause or prevent intumescences. The
removal of blue-green light with a yellow filter was found to reduce the formation of
intumescences of potato (‘AC Brador’ and ‘Shepody’) in a study performed by Seabrook and
Douglass (1998). This is contrary to a finding by Morrow and Tibbitts (1988), where the addition
of red light promoted intumescence development on potato, while blue and green lights had no
effect. As noted above, Lang and Tibbitts (1983) found that UV light affected intumescence
formation. When they exposed tomato plants to cool while fluorescent lights in a growth
chamber, intumescence development was prevented. A further link to light was found on work
by Frantz (2009) and Frantz et al. (2007) when working with Capsicum annuum L. ‘Triton.’
Extreme amounts of intumescences developed on the plants when grown under high pressure
sodium lights in a growth chamber, but did not develop in a greenhouse.

Several studies, cited in this literature review, mentioned that intumescence development
occurred only in controlled environments, such as greenhouses and growth chambers (Jaworski
et al., 1987; Kirkham and Keeney, 1974; Lang and Tibbitts, 1983; Lang et al., 1983; Petitte and
Ormrod, 1986). With the majority of the papers, the exception being LaRue (1933),
intumescence symptoms only seem to occur in controlled environments, which suggest that this
disorder is the result of a difference between field and controlled environment. Further research
should be undertaken to determine what differences between the environments contribute to

intumescence development so it can be prevented in the future.
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CHAPTER 2 - Root Medium Water Content and Supplemental
Calcium do not Influence the Occurrence of Edema in lvy

Geranium

Introduction



Edema is a physiological disorder characterized by blister-like formations on surfaces of
plant tissue that may become necrotic and form corky lesions. When severe, this damage reduces
the economic value of the crop. Researchers have evaluated this disorder in zonal geranium,
Pelargonium hortorum Ait., (Balge et al., 1969; Metwally et al., 1970; Metwally et al., 1970),
but only one published study focuses on edema in ivy geranium, Pelargonium peltatum L’Hérr
ex. Ait. (Rangarajan and Tibbitts, 1994), which is a highly susceptible species that contributes
significantly to the economic value of geraniums because of their widespread use in hanging
baskets (Holcomb and O’Donovan, 1993; NASS, 2008).

Current convention suggests that edema develops as a result of water uptake occurring
faster than transpiration rate, resulting in accumulation of water and solutes in leaf epidermal
tissue that gives rise to ‘blisters’ that eventually burst (Anonymous 1999a; Anonymous 1999b;
Anonymous 2001; Balge et al., 1969; Dudek, 2004; Lemon, 1996; Lerner, 2006; Metwally et al.,
1970; Micheal, 1996; Moorman, 1993; Ogelvee, 2003; Pataky, 1998; Pundt, 2005). It has also
been suggested that stomata may become blocked, further reducing plant transpiration (Balge et
al., 1969; Metwally et al., 1970). As a result, growers are encouraged to produce ivy geranium
under conditions of low humidity, maintain low root medium moisture content so that excess
water is not available for uptake, and irrigate in morning hours to provide sufficient time for
plants to transpire excess water (Balge et al., 1969; Dole and Wilkins, 2004; Metwally et al.,
1970; Metwally et al., 1970; Micheal, 1996; Moorman, 1993; Pataky, 1998). Applying
supplemental calcium (Ca) and providing an appropriate physiochemical environment in the root
medium for Ca uptake has also been suggested to abate the occurrence of edema (Micheal, 1996)
through a mechanism of strengthened cell walls; however, no research has documented the
effectiveness of this strategy. Therefore, the objectives of our research were to: 1) describe
edemata by using scanning electron microscopy (SEM); 2) determine whether root medium
water status plays a role in edema occurrence and severity; 3) evaluate the effectiveness of
providing supplemental calcium in abating the occurrence of edema; and 4) determine how

different plant transpiration rates affect the occurrence of edema.

Materials and Methods
Four experiments were conducted with ivy geranium (Pelargonium peltatum (L.) L’Hérr

ex Ait.), each with varying cultivars, root medium water status and supplemental Ca treatments
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to evaluate effect on the incidence and severity of edema. Day 1 for all experiments was the
transplant date. The first experiment occurred from 21 Apr. (day 1) to 30 May 2008 (day 70,
Spring 2008), the second from 4 Jun. (day 1) to 16 Aug. 2008 (day 74, Summer 2008), the third
from 3 Oct.. (day 1) to 18 Dec. 2008 (day 77, Fall 2008), and the fourth from 18 Feb. (day 1) to
18 May 2009 (day 1, Spring 2009).

The Spring 2008 experiment was a completely random design (CRD) with three water
status treatments (saturated, wet, and dry) x three cultivars (‘' Amethyst 96°, 'Lambada’ and
*Sybil Holmes”) and four replications. The Summer 2008 experiment was a randomized
complete block design (RCBD) with four blocks and the same treatments represented in the
Spring 2008 experiment with the addition of two supplemental calcium (Ca) treatments of 0 and
200 mg L™ Ca. The Fall 2008 experiment added another water status treatment—optimal—and
had a split plot design that consisted of two vapor pressure deficit (VPD) environments x four
water status treatments x two Ca levels (0 or 300 mg'L™) x four blocks on ‘Amethyst 96° only.
Finally, the Spring 2009 experiment was a RCBD with four blocks with three water status
treatments (optimal, wet and saturated) x three Ca levels (0, 500, or 1000 mg'L™) x two cultivars
(‘Amethyst 96’ and ‘Sybil Holmes”).

Plants and growing environment

The three ivy geranium cultivars that were used, ‘Amethyst 96°, ‘Lambada’ and ‘Sybil
Holmes’, all originated from Syngenta Flowers (formerly Fischer USA, Boulder, CO). Cuttings
from stock plants were taken on 17 Jan. 2008 (Spring 2008), 5 May 2008 (Summer 2008) and
‘Amethyst 96° only on 29 Aug. 2008 (Fall 2008). Cuttings were stuck into Oasis rooting cubes
(Smithers-Oasis Company, Cuyahoga Falls, OH) and rooted under mist for four weeks. For the
Spring 2009 experiment, rooted cuttings in Ellepots (Blackmore Company, Inc., Belleville, MI)
were obtained from C. Raker & Sons (Litchfield, MI). Cuttings in all experiments were
fertigated with 200 mg L™ N from 20N-4.4P-16.6K fertilizer (Peter’s 20-10-20 Peat-Lite
Special, Scotts Co., Marysville, OH) after transplant until experimental treatments were imposed.

Once rooted, cuttings were potted into round, green 16.5cm diameter x 11.5cm deep pots
with a volume of 730 ml. Pots were filled with Fafard 2 root medium (Conrad Fafard, Inc.,
Agawam, MA), a peat-based mix with perlite, on 15 Feb. 2008 (Spring 2008), 4 Jun. 2008
(Summer 2008), 3 Oct. 2008 (Fall 2008) and 18 Feb. 2009 (Spring 2009). The plants were then
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grown in a 7.6m x 7.6m glass greenhouse in the Throckmorton Plant Sciences range at Kansas
State University, Manhattan, KS, for the duration of the experiments.

Controlled release fertilizer, 19N-2.6P-9.9K (Osmocote 19-6-12, Scotts Co., Marysville,
OH) and a surfactant (Suffusion Granular, OHP Inc., Mainland, PA) were applied to each pot as
a top-dress at rates of 7g and 3.7g per pot, respectively, on 31 Mar. 2008 (day 11, Spring 2008)
and 27 Jun. 2008 (day 24, Summer 2008). Nine grams of fertilizer was applied per pot in the Fall
2008 and Spring 2009 experiments on 23 Oct. 2008 (day 21) and 23 Feb. 2009 (day 6),
respectively, along with 3.7 grams of surfactant. The fertilizer rate was increased due to the low
electrical conductivity (EC) readings of the previous two experiments. In addition to the nine
grams of controlled release fertilizer in Spring 2009, supplemental N was added as KNO3 at a
rate of 200 mg L™ N as described below.

Natural day lengths were used in all experiments. However, shade cloth was installed and
whitewash was applied to the outside surface of the greenhouse in an effort to control high
temperatures during the Summer 2008 experiment, and supplemental lighting via high intensity
discharge (HID) lights (Sun System I11 Model HPS 400 by Sunlight Supply Inc., Vancouver,
WA) were used from 0730 HR to 1730 HR during the Fall 2008 experiment.

Temperature and humidity were monitored using HOBO Environmental Monitors (Onset
Computer Corp., Bourne, MA). Average day : night temperatures, relative humidity (RH), and
vapor pressure deficits (VPD) are stated in Table 1. Vapor pressure deficits were calculated by

using Murray’s Equation (Murray, 1967);
17.269*TempAir
e, = "1 | 61078 (7 3 TemwAr
® 100

Thrips (Frankliniella occidentalis (Pergande) Thysanoptera: Thripidae) is a
phytophagous insect pest that causes feeding damage on ivy geranium very similar in appearance
to the physiological disorder edema. Therefore, this pest was tightly controlled with inundative
releases of predatory mites used as biological control agents. Amblyseius cucumeris ((Oudemans)
Acarina: Phytoseiidae; Thripex, Koppert B.V., The Netherlands) was released on all pots on 28
Mar. 2008 (day 8, Spring 2008) and 9 Jul. 2008 (day 36, Summer 2008). Similarly, Amblyseius
swirskii ((Athias-Henriot) Acarina: Phytoseiidae; Swirski-Mite, Koppert B.V., The Netherlands)
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was released on 24 Oct. 2008 (day 22, Fall 2008) and 9 Apr. 2009 (day51, Spring 2009) to
control thrips.

Leaves showing any symptoms of edema were marked prior to the start of the Summer
2008 experiment and removed at the start of the Fall 2008 and Spring 2009 experiments to
ensure that all the edema at the termination of the experiment was a result of the experimental

conditions.

Establishing root medium water content treatments

The watering regimes were established based on water loss by from pot weight, £10%.
Pots were weighed at the beginning of the experiment at container capacity; this starting weight
was then used to determine the percent dry down between irrigation events that determined
treatments. The dry, optimal, and wet treatments were irrigated after 65%, 30%, and 15% water
loss, respectively, from container capacity. The saturated treatment was maintained by keeping
the root medium uniformly and constantly moist by setting pots in a clear saucer (25.4 cm
diameter) that was always filled with water.

Water loss was measured by weighing representative pots in each treatment on a regular
basis, in conjunction with ECH,0 EC-5 probes (Decagon Devices Inc., Pullman WA). During
the first two dry down cycles in each treatment, pots were weighed and probe readings were
taken to correlate the % dry down by weight to the probe readouts; the probes were then used to
provide a rough estimate of the % dry down. Once the probes began to give readings similar to
those correlated with the pot weights, pots were weighed to determine the exact dry down
percentages in grams, fine tuning the system to give the most exact watering dates without the
need for daily weighing. This resulted in the wet treatments being watered about every to every-
other day, the optimal treatments were watered about weekly, and dry treatments were watered
every about every 11 to 14 days.

Except during Spring 2009, the fertilization regimen consisted solely of controlled release
fertilizer applied at transplant, as described above. Plants were irrigated with municipal water
(alkalinity as CaCO5; ~ 30 mg'L™ and Ca < 40 mg'L™) and a 15% (+5%) leaching fraction was
maintained for all experiments except during Spring 2009 when a 0% leaching fraction was
initially used. This lack of leaching, combined with supplemental fertilization with KNOg3 at a

rate of 200 mg L™ N at each irrigation as described above, lead to excessive salt levels in the
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root medium. Therefore, on day 52 of the Spring 2009 experiment, the optimal and wet
treatments were thoroughly leached by successively applying 600 ml of tap water four times.
After 20 days (day 72), a 20% leaching fraction (LF) was established and fertilizer was again
applied as 20N-8.7P-16.6K at a rate of 200 mg L™ N at every other irrigation event.

Establishing Ca treatments
Calcium was a treatment factor in the Summer 2008, Fall 2008 and Spring 2009

experiments. Calcium was applied at each watering interval from CaCl, at a rate of 200 mg L™
Ca (Summer 2008) or 300 mg L™ Ca (Fall 2008) following the watering regimen described
above; other plants were irrigated with municipal water. Since the saturated treatment did not
have a dry-down interval like the other treatments, 150 ml of the Ca solution was applied to the
treatment once weekly.

In the Spring 2009 experiment, Ca treatments included 0, 500 and 1000 mg ‘L™ Ca and
were applied as a part of the irrigation regimen. From 5 March 08 to 9 April 09 (days 16 to 51),
each Ca treatment was applied with each irrigation. This was reduced to every other watering
after a major leaching event was undertaken (10 April, day 52) to return EC levels to acceptable
levels (described above) and was maintained until the termination of the experiment. Plants in
the saturated water treatment received Ca applications on the same days as the optimal

treatments.

Establishing vapor pressure deficit treatments

Two vapor pressure deficit (VPD) environments were created for the Fall 2008
experiment. Tent-like structures were built out of 1-inch PVC pipe (Charlotte Pipe and Foundry
Co., Charlotte, NC) and plastic film (DuraGreen EM 3 Years OF D7/11; DuraGreen Marketing
USA, Mount Dora, FL) with dimensions of 101.6 cm x 115.6 cm x 91.6 cm tall. While each
treatment had the PVVC cage around the plants, the high VPD environment had plastic film only
on the top, in order to keep light quality as similar as possible between the two treatments; the
low VPD experiment had plastic film on all but the bottom of the tent with access flaps on two
opposite sides of the tent secured with Velcro. A mist system ran underneath the bench to

provide supplemental humidity to the low VPD treatments and ran for 15 min hourly (0000,
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0300, 0500, 0700, 0800, 0900, 1100, 1200, 1300, 1400, 1500, 1600, 1800, 2100 HR) on the 24 hr
clock, while fans were set up to constantly blow air over the plants in the high VPD treatments.
Water stress was monitored in this experiment using Decagon’s Leaf Porometer SC-1
(Decagon Devices, Inc; Pullman, WA). All plants were measured daily for 17 days (17 Nov. to 3
Dec. 2009, days 46 to 62) to determine if the root medium water status and VPD environments

were affecting the stomatal resistance, and thus transpiration, of the plants.

Growth data at harvest
Plant height was taken by measuring from the root medium surface to the top of the
foliage canopy (Fall 2008 and Spring 2009). Plant width was determined in all experiments by
averaging two measurements taken at 90 degrees to each other. Fresh and dry weights were
measured on whole, above-ground plant shoots at the termination of all experiments. Dry
weights were obtained by drying the whole, above-ground plant shoots at 70°C in a forced-air

oven.

Tissue analysis
Whole shoots (Summer 2008) or youngest, fully-expanded leaves (Fall 2008 and Spring

2009) were collected for tissue analyses, washed in 0.1 N HCI and rinsed in distilled water twice,
followed by briefly soaking in reverse osmosis water. Dried tissue was ground to pass a 20-
mesh screen in preparation for tissue analysis for Ca and magnesium (Mg; Summer 2008, Fall
2008 and Spring 2009) using a nitric-perchloric acid digestion. ICP Spectrometry (Model 720-
ES ICP Optical Emission Spectrometer, Varian Australia Pty Ltd, Mulgrave, Vic Australia)
using Nitric-Perchloric digested plant material was used to analyze samples for Ca and Mg.

Root medium testing
Root media at the end of all experiments were extracted using the saturated media
extract (SME) method (Warncke, 1986) and analyzed for pH and EC using an Extech Model
6595 pH/Conductivity/TDS/Temperature meter (Extech Instruments Corp.; Waltham, MA);
Spring 2008 and Summer 2008) or an Accumet Excel XL20 pH/Conductivity meter (Thermo
Fisher Scientific Inc.; Waltham, MA; Fall 2008 and Spring 2009). During Spring 2009, leachate
was collected using the pour-through method during the experiment (Yeager, 1983) and at the

termination of the experiment using the SME method and analyzed for soluble Ca content using
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an inductively coupled plasma spectrometer (Model 720-ES ICP Optical Emission Spectrometer,

Varian Australia Pty Ltd, Mulgrave, Vic Australia).

Edema characterization

Whole plant ratings were taken at harvest in the Spring 2008, Summer 2008 and Fall
2008 experiments. Given the lack of correlation between edema ratings and actual edema
damage measured by the scanning procedure (described below) during Summer 2008 or Fall
2009, ratings were dropped in the Spring 2009 experiment in favor of the scanning procedure.

The whole-plant edema rating system, based on the incidence and severity of edema, is as
follows: 0 = no edema; 1 = a few edemata beginning to form on 3 or fewer leaves; 2 = a few
edemata forming on 4 or more leaves or numerous edemata on 3 or fewer leaves; 3 = numerous
edemata on 4 or more leaves or callusing of edemata on 3 or fewer leaves; 4 = edema on all fully
expanded leaves with some callusing on multiple leaves; 5 = edema on all fully expanded leaves
and callusing on almost all leaves with some lesions forming on adaxial surface. The edema
primarily forms on the abaxial surfaces of leaves in these cultivars of ivy geranium, until the
lesions are so severe they form on the adaxial surface as well; therefore, the ratings primarily
focused on abaxial surfaces until the damage became severe enough to affect the adaxial surface.

To truly quantify the edema damage, all leaves from Summer 2008, Fall 2008 and Spring
2009 experiments were scanned with a flatbed scanner (Epson Perfection 4990 Photo; Seiko
Epson Corp., Suwa, Nagano, Japan) and evaluated for total leaf area and leaf area affected by
edema using Adobe Photoshop 7.0 (Adobe Systems Inc., San Jose, CA) and Scion v. 4.0.3.2
(Scion Corp., Frederick, MD) following the procedure outlined in Chen and Williams (2006) and
Appendix B. The procedure used to select damaged tissue for Spring 2009 was the ‘lasso
method’, which was different compared to the ‘color-range method’ used for Summer 2008 and
Fall 2008 (Appendix B).

Scanning electron microscopy (SEM) and dissection microscopy (DM)
Scanning electron micrographs were taken of tissue samples from the abaxial surface of
selected ivy geranium leaves in the Spring 2009 experiment. Small pieces of leaf, approximately
75 mm?, were glued onto a SEM slide using a graphite emulsion. The slides were placed into the

scanning electron microscope (S-3500N Hitachi Science Systems Ltd., Hitachinaka, Japan) and
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were rapid cooled using liquid nitrogen to fix the samples. Micrographs were taken under high
vacuum using a backscatter detector (Robinson Detector ETP-USA/Electron Detectors Inc.,
Rocklin, CA).

A dissection microscope (Nikon SMZ1500; Nikon Corp., Kawasaki, Japan) with digital
camera attachment (Nikon Digital Sight DS-5M; Nikon Instruments Inc., Melville, NY) was
used to photograph edemata on the abaxial surface of ivy geranium leaves at magnifications of
3X and 8X.

Statistical procedures
Analysis of variance was conducted on results from each experiment using PROC GLM
and PROC MIXED in SAS ver. 9.1.3 (SAS Institute Inc., Cary, NC). For Fall 2008, the data set
was analyzed two ways: 1) the low VPD environment treatment was removed to better determine
the role root medium water content had on oedema development; 2) the dry root medium water
content treatments were removed as the treatment within the low VPD environments was

compromised by the mist system.

Results and Discussion

Scanning electron microscopy (SEM) and dissection microscopy (DM)

As seen in Figs. 2.1 and 2.2, a single edemata is comprised of multiple cells. It appears
that edemata are formed when water and solutes build up underneath or possibly within cells of
the abaxial epidermis, causing epidermal cells to stretch. When viewed under a dissection
microscope, as in Fig. 2.3 and 2.4, the edemata appear to collapse, not rupture. This lack of
rupture is confirmed by SEM (Fig.2.5). This finding is different from current conventional
wisdom that suggests that epidermal cells rupture (Balge et al., 1969) and result in the necrotic,
scab-like lesions. Instead, the necrosis may be due to intracellular connections separating,
irreparably damaging pathways of water and nutrient movement to affected cells. Stomatal
blockage has also been implicated in this disorder (Balge et al., 1969; Metwally et al., 1970).
However, our SEMs did not suggest that stomata were affected or blocked in the pre-necrotic

stages of edemata formation.
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Effect of root medium water content

Increased root medium water contents tended to result in larger plant size compared to
‘dry” treatments (Tables 2.2 to 2.5). Surprisingly, plants maintained as the saturated treatment
showed no signs of root rot in any of our experiments despite constant saturation of the root zone
with water.

The wet and saturated root medium treatments resulted in similar growth and the dry
treatment was smaller in the Spring 2008 experiment (Table 2.2). In Summer 2008 (Table 2.3),
the saturated and wet root medium water content treatments again performed similarly based on
all growth parameters, which included width, fresh weight, dry weight and leaf area, while the
dry treatment was smaller. Root medium EC at the end of the experiment was slightly lower for
the saturated treatment (1.2dS/m) compared to the wet and dry treatments (1.3 to 1.4 dS/m, Table
2.9).

In the Fall 2008 experiment, no growth differences occurred between root medium water
content treatments when results from only the high VPD environment were analyzed (Table
2.4a), though the EC was lower in the wet treatment (0.5 dS/m) compared to the saturated,
optimal, and dry treatments (0.7 to 0.8 dS/m, Table 2.10a). This low overall EC may have
contributed to the lack of growth differences between water status treatments.

When VPD environment was included in the analysis, the interaction between VPD
environment X root medium water content occurred across all growth parameters (Table 2.4b).
Results were similar based on width, fresh weight, and leaf area: growth was similar across VPD
environments and root medium water content treatments except that the wet treatment in the high
VVPD environment was smaller. Dry weight differences were not as clear cut: smallest plants
were again the wet treatment in the high VVPD environment, but these were similar in dry weight
to the high VPD-optimal and low VPD-saturated plants (Table 2.4b). These growth results are
easily explained by the excessive mechanical damage from moving tissue for daily watering that
resulted in branches breaking off of plants in the high VPD-wet treatment, leading to less
growth. Despite efforts to accomplish two distinctly different VPD environments in the Fall 2008
experiment, environmental conditions were not dramatically different between environments
(Table 2.1). Stomatal conductance of optimal, wet, and saturated treatments was similar between
the two environments (Fig. 2.6) which explains why there is not marked difference in plant
response between the environments.
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In Spring 2009, the saturated treatment resulted in larger plants compared to both the wet
and optimal treatments, which were similar in size based on every parameter except width (Table
2.5). A water x cultivar interaction occurred for plant width (Table 2.5) because ‘Amethyst 96’
and ‘Sybil Holmes’ had similar plant widths in the saturated and optimal treatments, but ‘Sybil
Holmes’ resulted in much greater width than ‘Amethyst 96° when grown under the wet treatment
regimen. The EC at the end of the experiment was different between root medium water content
treatments: saturated was higher (3.4 dS/m) compared to wet and optimal (2.4 to 3.2 dS/m;
Table 2.11).

Growing ivy geranium at reduced root medium water content did not result in preventing
or reducing edema (Tables 2.2, 2.6 to 2.8). In Spring 2008, subjective, whole-plant edema ratings
taken at the end of the experiment were not different between root medium water content
treatments (Table 2.2). In Summer 2008, the cultivar x water interaction was significant: the dry
treatment of only one cultivar, ‘Amethyst 96°, had more edema damage than other cultivars and
root medium water content treatments (Table 2.6). One hypothesis is that the extreme dry down
included in the Summer 2008 experiment may have aggravated the disorder on this one cultivar,
‘Amethyst 96° (Table 2.6), possibly due to rapid uptake of water after the completion of the dry
down cycle that exceeded plants’ ability to transpire excess water. But if this theory was valid,
the same result should have occurred on the dry root medium treatment of the other two
cultivars, and it did not. In Fall 2008 and Spring 2009, water had no effect on percent edema
damage (Tables 2.7a and b, 2.8). In Spring 2009, leaf area affected by edema was influenced by
root medium water content (Table 2.8); however, differences in plant size between the water
treatments (Table 2.5) explains this result as the total affected area and total leaf area were used
to calculate percent damage.

Contrary to conventional wisdom derived from previous research (Balge et al., 1969;
Metwally et al., 1970; Metwally et al., 1970; Metwally et al., 1971), the saturated treatment
resulted in similar edema damage compared to the optimal and wet root medium water
treatments. Even different transpiration rates measured in the Fall 2008 experiment between the
dry versus optimal, wet and saturated treatments (Fig. 2.6) did not result in a difference in
edema damage (Table 2.7a). Other researchers have suggested that water uptake that exceeds
plant transpiration may contribute to causing this disorder (Balge et al., 1969; Khan and Conde,
2008; Metwally et al., 1970); our results do not support this theory but are inconclusive because
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plant growth during the Fall 2008 experiment was not maximized by fertilization (as discussed
earlier relating to EC levels in Tables 2.10a and 2.10b) and warmer production environment
(Table 2.1).

Root medium water content treatments tended to affect medium pH, measured at the end
of the experiment, differently between experiments. The dry root medium water content
treatment in the Summer 2008 experiment resulted in a pH of 5.4, which was higher than for
other treatments that ranged from 4.8 to 5.0 (Table 2.9). Also in Summer 2008, ‘Sybil Holmes’
resulted in a higher pH of 5.3 compared to ‘Amethyst 96” and ‘Lambada’, which ranged from 4.9
to 5.0 (Table 2.9). There were no differences in pH in the Fall 2008 experiment (Tables 2.10a
and 2.10b). In the Spring 2009 experiment, pH was highest in the saturated water status
treatment at 5.0 compared to 4.3 to 4.5 for the wet and optimal treatments, respectively (Table
2.11). In Spring 2009 as in Summer 2008, ‘Sybil Holmes’ resulted in a higher pH (4.6) compared
to ‘Amethyst 96’ (4.5, Table 2.11). Ultimately, these pH values are moderately low and may

have contributed to reducing availability of Ca and Mg for uptake by the plant, as discussed later.

Effect of supplemental calcium

Application of supplemental Ca did not increase growth in any experiment (Tables 2.3 to
2.5). Supplemental Ca at a rate of 200 mg L™ in the Summer 2008 experiment resulted in a
smaller leaf area at 552 cm? compared to 682 cm? in the 0 mg L™ Ca treatment (Table 2.3),
though this response was implicated in a three-way interaction. No other growth characteristics
were affected by supplemental Ca in that experiment and no growth characteristics were affected
by supplemental Ca in the Fall 2008 experiment (Tables 2.4a and 2.4b).

In the Spring 2009 experiment, the highest level of 1000 mg L™ Ca resulted in smaller
plants (Table 2.5) with an average fresh weight of 197 g compared to 235 g and 238 g in the O
and 500 mg' L™ Ca treatments, respectively. Dry weights in this experiment were not different
while leaf areas followed a similar pattern to fresh weights (Table 2.5). This growth response
was due to high salt levels in the root medium (Fig. 2.7, Table 2.11). The fertilization regimen
was increased compared to previous experiments to provide luxurious nutrition. This resulted in
EC levels being slightly high for ivy geraniums receiving the 0 and 500 mg' L™ Ca treatments,
but very high in the 1000 mg L™ Ca treatment, which explains the lack of vigor in that treatment

compared to those receiving lower rates of supplemental Ca. The balancing anion in the
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supplemental Ca solution was chloride, so the salt build up over time in relation to the
supplemental Ca rate was not surprising.

Levels of Ca varied across experiments: tissue Ca averaged in the low 5% range in
Summer 2008 (whole shoots, Table 2.9), low 1 to 1.5% in Fall 2008 (youngest, fully-expanded
leaves, Tables 2.10a and 2.10b), and 1.0 to 1.8% in Spring 2009 (youngest, fully-expanded
leaves, Table 2.11). In all experiments, tissue analyses suggested that adequate Ca was absorbed
by plants that received no supplemental doses (0 mg' L™ Ca treatments). Adequate Ca was
provided by pre-plant dolomitic lime amendments to the root media and the irrigation water,
which provided ~30 to 35 ppm Ca at each irrigation (municipal source, Manhattan, KS). Despite
the fact that pH tended to be moderately low for optimal Ca uptake (Tables 2.9 to 2.11), tissue
Ca concentrations fell within the sufficiency range of 0.9 to 1.4% for ivy geranium (Dole and
Wilkins, 1999) in all treatments.

Supplemental Ca did not affect edema occurrence as no experiment resulted in significant
percent damage based on Ca treatment (Tables 2.6 to 2.8). Therefore, either supplemental Ca did
not strengthen epidermal cell walls in ivy geranium in these experiments, or strengthening cell
walls in general did not affect edema occurrence. In the Fall 2008 and Spring 2009 experiments,
supplemental Ca applications resulted in decreases in Mg concentrations within plant leaves, a
result of antagonism of Ca uptake by Mg (Tables 2.10a, 2.10b and 2.11). The antagonism was
not significant in the Summer 2008 experiment when only 200 mg' L™ supplemental Ca was
provided, but 300 mg' L™ supplemental Ca and greater in the subsequent experiments resulted in
this distinct effect.

Interactions between water x supplemental Ca were observed in the Summer 2008, Fall
2008 and Spring 2009 experiments (Tables 2.9, 2.10a and 2.11) for Ca and Mg tissue
concentrations. In Summer 2008, the wet treatment resulted in higher tissue Ca (~7.4%)
compared to the saturated and dry treatments (3.3 to 4.6%); the dry treatment resulted in most
Mg (Table 2.9). In Fall 2009, Mg tissue concentrations were similar between the 0 mg' L™ and
300 mg L™ supplemental Ca treatments in the saturated and dry and different in the wet and
optimal root medium water content treatments In the Spring 2009 experiment, tissue Ca was
similar between the three supplemental calcium treatments in the saturated treatment; 500 mg' L™
and 1000 mg L™ supplemental Ca treatments were similar in the wet and optimal treatments but
different from the 0 mg' L™ Ca in those two water content treatments. Tissue Mg were similar
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between the 0 mg' L™ and 500 mg' L™ Ca and different from the 1000 mg' L™ supplemental Ca
treatment in the saturated root medium water content, and all were different in the wet and
optimal root medium water content treatments.

All of the abovementioned interactions may be explained by the frequency of the
supplemental Ca application between root medium water content treatments. In Fall 2008, the Ca
drenches were applied at similar intervals between the dry (about every 1.5 weeks) and saturated
treatments (weekly), whereas the wet treatment received the calcium drench almost daily and the
optimal treatment was watered at irregular intervals between 5 and 9 days. The interaction in the
Spring 2009 experiment is similar. The interval in which the wet root medium water content
treatment received supplemental Ca (every 1 to 3 days) was right in the middle of the intervals in
which the saturated (weekly) and optimal (every 3 to 5 days) treatments received drenches. This
explains why the more frequently watered treatments had higher Ca levels in their tissue.

A three-way interaction between VPD environment, root medium water content treatment
and supplemental Ca occurred in Fall 2008 for height (Table 2.4b). Generally, height followed a
similar pattern to the two-way interaction with VPD x water. However, supplemental Ca often
resulted in the same height or smaller than plants not receiving supplemental Ca, with the
exception of the saturated water treatment in the high VVPD environment where plants were larger
with the addition of supplemental Ca. This is a curious anomaly because across these
experiments supplemental Ca either had no effect on growth or tended to result in smaller plants
if applied at high levels.

Effect of environmental conditions

As discussed earlier, the experiment (Fall 2008) to test the effect of two vapor pressure
deficits on edema occurrence did not produce environments that were sufficiently different to
adequately evaluate the question (Table 2.1). However, we did observe different transpiration
rates in the high VPD environment between the dry treatment and the wetter treatments (Fig.
2.6A\), but stomatal conductance of optimal, wet, and saturated treatments was similar between
the two environments (Fig. 2.6 B and C).Temperature had a role in our growth results between
experiments. High temperatures lead to leaf bleaching (Dhir, 2008) in the Summer 2008
experiment, which affected the edema scanning procedure (Appendix B) and required

modification by individually masking all of the bleached areas on affected leaves to correct
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inaccuracies in leaf area. Low temperatures in the Fall 2008 experiment may have contributed to
the lack of growth differences between treatments, since temperatures were kept cool to prevent

heat build up, and thus more leaf bleaching, in our VPD cages.

Summary

While environment (Table 2.1) and plant nutrient status were different across the
experiments and should be factored into the interpretation of these results, major findings were
similar across experiments. Supplemental Ca did not have any effect on edema in any of the
experiments; therefore, we found no evidence to encourage growers to provide supplemental Ca
drenches as a means to abate edema. Similarly, a range of root medium water contents did not
have a marked effect on differences in edema occurrence or severity, which is also contrary to
previous convention. Different transpiration rates resulting from dry versus optimal to saturated
root medium water contents also had no affect on edema occurrence. Finally, the idea that edema
results in epidermal cells bursting needs to be re-evaluated based on evidence from scanning
electron and dissection scope micrographs. Further research could focus on manipulating
humidity and VPD in well-controlled experimental environments to determine environment’s
affect on the occurrence and severity of edema. In addition, the effect on edema when rapid, soft
growth is being pushed may provide answers to plant status that result in greatest susceptibility.
Finally, selecting ivy geranium cultivars more resistant to this disorder offers perhaps the best

option for growers to manage it.
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BSE1 28-May-09

Figure 2.1 Scanning electron micrograph of a single edemata on the abaxial surface of a leaf of
the ivy geranium cultivar ‘Amethyst 96.” A: Cells being affected by the edemata; B: Stomata; C:

Normal, unaffected cell; D: Primary vein; E: Trichome
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Figure 2.2 Dissection micrograph of a single edemata on the abaxial surface of the ivy geranium
cultivar ‘Amethyst 96.
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Figure 2.3 Dissection micrograph of a collapsed and necrotic edemata on the abaxial surface of a
leaf of the ivy geranium cultivar ‘Amethyst 96.” A: Edemata cells still exhibiting the swelling

characteristic; B: Mature edemata cells that have collapsed and turned necrotic; C: Trichome; D:

Unaffected cells
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Figure 2.4 Dissection micrograph of a collapsed and edemata on the abaxial surface of a leaf of
the ivy geranium cultivar ‘Amethyst 96.” A: Edemata cells still exhibiting the swelling
characteristic; B: Mature edemata cells that have collapsed and turned necrotic; C: Dissection

needle; D: Shadow of dissection needle showing collapse of edemata.
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BSEl 28-May-09

Figure 2.5 Scanning electron micrograph of a maturing edemata on the abaxial surface of a leaf
of the ivy geranium cultivar ‘Amethyst 96.” A: Edemata cells still exhibiting the swelling
characteristic; B: Maturing edema-affected cells collapsing; C: Stomata; D: Cracking of cells
affected by edemata likely caused by the rapid freezing of the tissues prior to scanning; E:
Regions on edemata appear white on SEM which suggests accumulation and higher

concentration of heavy metals.
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Figure 2.6 Stomatal resistances over the course of one full irrigation cycle of the dry root
medium water content treatment. Higher stomatal resistances indicate lower transpiration rates
via stomatal closure. Standard error bars are included at every data point, but may be masked by
markers. A: Stomatal resistances of all root medium water content treatments in the high VPD
environment; B: Stomatal resistance in the high VPD environment without the dry water
treatment included; C: Stomatal resistances of all root medium water contents in the low VPD

environment.
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Electrical Conductivty via Pour-Through: Calcium Treatments
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Figure 2.7 Electrical conductivities (EC), analyzed by the pour-through method, on four dates
during the Spring 2009 experiment. A full experiment, root media leach took place on 10 April

2009 (Day 52) indicated by the arrow, dropping EC levels back down to tolerable levels.
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Table 2.1 Plant growth characteristics and subjective edema ratings from the Spring 2008
experiment taken at the end of the production period (Day 70) of three ivy geranium cultivars

grown under three root medium water content regimens: saturated, wet or dry.

Fresh
Weight Dry Weight Edema
)] )] Rating”
Cultivar NSY NS NS
Water NS * NS
Water*Cultivar NS NS NS
Water * Cultivar
Cultivar - 'Amethyst 96'

Saturated 153.8 154 2.0

Wet 132.3 13.2 3.3

Dry 112.8 10.7 2.4

Cultivar - 'Lambada’

Saturated 150.8 14.3 2.9

Wet 127.5 12.1 3.0

Dry 115.8 10.0 2.1

Cultivar - 'Sybil Holmes'

Saturated 117.8 11.3 2.1

Wet 156.3 15.3 2.1

Dry 98.5 8.5 15
Cultivar ‘Amethyst 96’ 133 13.1 2.5

‘Lambada’ 131 12.1 2.7

‘Sybil Holmes’ 124 11.7 1.9
Water Saturated 109 13.7a* 2.3

Wet 139 13.5a 2.8

Dry 141 9.7b 2.0

Z The whole-plant edema rating system, based on the incidence and severity of edema, is as follows: 0 = no edema; 1
= a few edemata beginning to form on 3 or fewer leaves; 2 = a few edemata forming on 4 or more leaves or
numerous edemata on 3 or fewer leaves; 3 = numerous edemata on 4 or more leaves or callusing of edemata on 3 or
fewer leaves; 4 = edema on all fully expanded leaves with some callusing on multiple leaves; 5 = edema on all fully
expanded leaves and callusing on almost all leaves with some lesions forming on adaxial surface.

VNS, *, ** ***x *xxx Nonsignificant or significant at P=0.05, 0.01, 0.001, and 0.0001, respectively.

*If no LSDy gs is listed, different letters indicate that means are significantly different based on pair-wise
comparisons at a=0.05.
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Table 2.2 Plant growth characteristics from the Summer 2008 experiment taken at the end of the
production period (Day 74) of three ivy geranium cultivars grown under three root medium water

content regimens: saturated, wet or dry, with either 0 or 200 mg-L™ supplemental calcium.

Fresh Dry Leaf
Width Weight Weight Area
(cm) 9 (9 (cm"2)
Block NS* NS NS NS
CU|tIV&I’ ** **kk*k **kk*k *kkk
Water ** *k* *kkk *kkk
Calcium NS NS NS *
Cultivar*Water NS NS NS NS
Cultivar*Calcium NS NS NS NS
Water*Calcium NS NS NS NS
Cultivar*Water*Calcium NS NS NS *
Cultivar*Water*Calcium
Cultivar - 'Amethyst 96'
Saturated Ca 20.4 34.3 3.4 407
No Ca 21.6 42.0 2.9 525
Wet Ca 19.4 26.8 2.7 384
No Ca 23.5 41.8 3.6 717
Dry Ca 16.8 26.0 2.5 352
No Ca 18.1 24.3 2.4 342
Cultivar - 'Lambada’
Saturated Ca 18.6 36.5 3.3 512
No Ca 16.7 36.3 2.9 478
Wet Ca 18.9 34.0 2.9 532
No Ca 24.6 41.3 5.4 914
Dry Ca 16.5 26.8 2.3 382
No Ca 16.7 28.3 2.4 414
Cultivar - 'Sybil Holmes'
Saturated Ca 20.5 55.3 4.5 733
No Ca 28.8 81.0 6.4 1165
Wet Ca 26.5 84.5 6.9 1144
No Ca 25.9 70.8 6.2 994
Dry Ca 20.1 41.8 35 521
No Ca 22.4 43.3 3.3 585
Cultivar*Water
Amethyst-96 Saturated 21.0 38.1 3.1 466
Wet 21.5 34.3 3.1 551
Dry 17.5 25.1 2.4 347
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‘Lambada’

‘Sybil Holmes’

Cultivar*Calcium
‘Amethyst-96°

‘Lambada’

‘Sybil Holmes’

Water*Calcium
Saturated

Wet

Dry

Cultivar

‘Amethyst-96°
‘Lambada’
‘Sybil Holmes’

Water

Calcium

Saturated
Wet
Dry

Saturated
Wet
Dry

Ca
No Ca

Ca
No Ca

Ca
No Ca

Ca
No Ca

Ca
No Ca

Ca
No Ca

Saturated
Wet
Dry

Ca
No Ca

17.6
21.8
16.6

24.7
26.2
21.3

18.9
21.1

18.0
19.3

22.7
25.7

19.8
22.4

21.6
24.7

17.8
19.1

19.9b”
18.7b
24.1a

21.1a
23.1a
18.4b

19.7
22.0

36.4
37.6
27.5

68.1
77.6
42.5

29.0
36.0

32.4
353

60.5
65.0

42.0
53.1

48.4
531

315
31.9

32.5b
33.8b
62.8a

47.5a
49.8a
31.7b

40.6
45.4

3.1
4.1
2.3

5.4
6.5
3.4

2.8
2.9

2.8
3.6

4.9
5.3

3.8
4.0

4.1
5.1

2.8
2.7

2.9b
3.2b
5.1a

3.9a
4.6a
2.7b

3.6
3.9

495
723
398

949
1069
553

381
528

476
602

799
915

551
723

687
875

418
447

454
539b
857a

637a
781a
433b

552b
682a




ZNS, *, ** #**x sxx% Nonsignificant or significant at P=0.05, 0.01, 0.001, and 0.0001, respectively.
YIf no LSDy s is listed, different letters indicate that means are significantly different based on pair-wise
comparisons at 0=0.05.
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Table 2.3 a and b. Plant growth characteristics from the high VPD treatment of the Fall 2008°
experiment taken at the end of the production period (Day 77) of the ivy geranium cultivar
‘Amethyst 96’ grown under four root medium water content regimens: saturated, wet , optimal,

or dry with either 0 or 300 mg-L™* supplemental calcium.

Fresh Dry Leaf
Height ~ Width  Weight  Weight Area
(cm) (cm) (9) (9) (cm”"2)
Block NS NS NS NS NS
Water NS NS NS NS NS
Calcium NS NS NS NS NS
Water*Calcium NS NS NS NS NS
Water*Calcium
Saturated Ca 18.9 26.5 97.0 8.67 1331
No Ca 17.1 24.6 82.8 6.67 1114
Wet Ca 17.8 23.8 76.0 6.53 878
No Ca 18.4 23.2 82.7 7.00 1073
Optimal Ca 18.8 25.7 90.8 8.26 1265
No Ca 21.6 23.3 82.4 7.43 1003
Dry Ca 18.9 20.7 63.4 5.26 779
No Ca 16.3 21.7 67.0 5.88 888
Water Saturated 18.0 25.5 89.9 7.76 1222
Wet 18.1 23.5 79.4 6.77 976
Optimal 20.2 24.5 86.6 7.84 1134
Dry 17.6 21.2 65.2 5.57 834
Calcium Ca 18.9 24.1 81.8 7.18 1063
No Ca 18.3 23.2 78.7 6.74 1020

? Statistical analysis does not include the low VPD environment treatment
YINS, *, **, *** “*** Non-significant or significant at P=0.05, 0.01, 0.001, and 0.0001, respectively.
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Table 2.3b Plant growth characteristics from the Fall 2008 experiment taken at the end of the
production period (Day 77) of the ivy geranium cultivar ‘Amethyst 96 grown under four root
medium water content regimens: saturated, wet , optimal, or dry with either 0 or 300 mg-L™

supplemental calcium.

Fresh Dry Leaf
Height ~ Width  Weight  Weight Area
(cm) (cm) 9) (9) (cm"2)
Block *x NS NS NS NS
VPD Fekdkk NS NS NS NS
Water NS NS NS NS NS
Calcium NS NS NS NS NS
VPD*Water *k*k*k * **k* * **
VPD*Calcium NS NS NS NS NS
Water*Calcium NS NS NS NS NS
VPD*Water*Calcium * NS NS NS NS
Water * Ca *VPD
VPD - High
Saturated Ca 20.9b 27.3 118.3 10.5 1522
No Ca 16.0c 26.0 92.0 7.2 1210
Wet Ca 10.4e 19.7 32.0 3.3 354
No Ca 13.9d 19.6 56.3 5.4 647
Optimal Ca 17.4bc 24.5 99.3 9.3 1137
No Ca 20.9b 21.8 66.3 5.7 805
VPD - Low
Saturated Ca 17.0c 25.6 75.8 6.8 1140
No Ca 18.1b 23.1 73.5 6.2 1019
Wet Ca 25.1a 27.8 104.5 8.6 1191
No Ca 23.0a 26.8 93.0 7.4 1254
Optimal Ca 20.1ab 26.9 82.3 7.3 1393
No Ca 22.4a 24.9 98.5 9.2 1268
LSDg 05" 3.6 NS NS NS NS
VPD*Water
VPD-High Saturated 18.4bc  26.7a  105.1a 8.9a 1366a
Wet 12.1d 19.6b 44.1b 4.4b 501b

Optimal 19.1bc 23.2a 82.8a 7.5ab 971a
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VPD-Low Saturated  17.6¢ 24.4a 74.6a 6.5ab 1079a
Wet 24.1a 27.3a 98.8a 8.0a 1223a
Optimal ~ 21.3ab 25.9a 90.4a 8.2a 1330a

LSDg0s 3.6 6.4 33.3 3.3 523
VVPD*Calcium
VPD-High Ca 16.2 23.8 83.2 7.7 1004
No Ca 16.9 225 82.4 7.4 887
VPD-Low Ca 20.8 26.8 87.5 7.6 1241
No Ca 21.2 24.9 88.3 7.6 1180
Water*Calcium
Saturated Ca 18.9 26.5 97.0 8.7 1331
No Ca 17.1 24.6 82.8 6.7 1114
Wet Ca 17.8 23.8 68.3 6.0 772
No Ca 18.4 23.2 74.6 6.4 951
Optimal  Ca 18.8 25.7 90.8 8.3 1265
No Ca 21.6 23.3 82.4 7.4 1036
VPD High 16.6 23.1 77.3 6.9 946
Low 21.0 25.9 87.9 7.6 1211
Water Saturated  18.0 25.5 89.9 7.7 1222
Wet 18.1 235 71.4 6.2 862
Optimal 20.2 245 86.6 7.8 1151
Calcium Ca 18.5 25.3 85.3 7.6 1223
No Ca 19.0 23.7 79.9 6.8 1034

? Statistical analysis does not include the dry root medium water content treatment

INS, *, ** *** **+% Non-significant or significant at P=0.05, 0.01, 0.001, and 0.0001, respectively.

XLSD calculated as: LSD=tV(2(EMS)/# obs. per mean) where t is determined at 0=0.05 and df of error term. LSD is
used to compare within a row and within a column of the factorial treatment structure.
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Table 2.4 Plant growth characteristics from the Spring 2009 experiment taken at the end of the
production period (Day 90) of two ivy geranium cultivars grown under three root medium water
content regimens: saturated, wet , or optimal with either 0, 500, or 1000 mg-L™ supplemental

calcium.
Fresh Dry Leaf
Height  Width Weight  Weight Area
(cm)  (cm) @ )] (cm"2)
Block NS* NS NS NS NS
Cultivar Fxx * NS NS NS
Water NS **kk*k *kk*k *kkk *kkk
Calcium NS Fxk *x NS *x
Cultivar*Water NS * NS NS NS
Cultivar*Calcium NS NS NS NS NS
Water*Calcium NS NS NS NS NS
Cultivar*Water*Calcium NS NS NS NS NS
Cultivar*Water*Calcium
Cultivar - 'Amethyst 96'
Saturated 0 25.0 48.0 301 24.0 2935
500 26.0 55.4 320 27.6 3225
1000 23.3 44.3 274 25.3 2737
Wet 0 24.5 46.4 222 19.8 2141
500 24.3 43.0 218 18.4 2018
1000 22.8 34.8 190 14.7 1749
Optimal 0 27.3 36.4 202 16.6 1872
500 24.3 34.8 187 16.6 1810
1000 24.3 30.8 163 14.3 1511
Cultivar - 'Sybil Holmes'
Saturated 0 24.7 48.4 313 22.2 1889
500 21.5 50.8 289 22.3 3079
1000 23.0 41.3 276 23.7 1021
Wet 0 225 100.2 148 11.3 2481
500 19.0 45.2 230 13.8 3075
1000 20.0 37.5 135 16.7 1703
Optimal 0 24.0 39.0 228 19.4 2343
500 19.8 36.4 184 13.4 1903
1000 18.8 38.8 142 11.0 1451

Cultivar*Water
Amethyst-96 Saturated 248 49.2b 298 25.6 2966
Wet 23.8 41.2bc 210 17.6 1969
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Optimal 253 34.0c 184 15.8 1731
‘Sybil Holmes’  Saturated 23.1  46.8b 293 22.7 1996
Wet 205 61.0a 171 13.9 2420
Optimal 20.8  38.0c 185 14.6 1899

LSDg o5’ NS 8.0 NS NS NS

Cultivar*Calcium

‘Amethyst-96" 0 25.6 43.6 241 20.1 2316
500 24.8 44.4 242 20.9 2351
1000 23.4 36.6 209 18.1 1999
‘Sybil Holmes” 0 23.7 62.5 229 17.6 2237
500 20.1 44.1 235 17.5 2686
1000 20.6 39.2 185 16.2 1392

Water*Calcium
Saturated 0 24.8 48.2 307 23.1 2412
500 23.8 53.1 305 24.9 3152
1000 23.1 42.8 275 24.5 1879
Wet 0 23.5 73.3 185 15.6 2311
500 21.6 44.1 224 17.6 2547
1000 21.4 36.1 163 14.2 1726
Optimal 0 25.6 37.7 215 18.0 2107
500 22.0 35.6 186 15.0 1857
1000 21.5 34.8 153 12.7 1481

Cultivar

‘Amethyst-96> 24.6a* 41.5b 231 19.7 2222
‘Sybil Holmes” 21.5b  48.6a 216 17.1 2105
Water Saturated 239 48.0b 296a 24.2a  248la
Wet 22.2 51.2a 191b  15.8b 2194b
Optimal 23.0 36.0c 184b  15.2b 1815b
Calcium 0 24.7a  53.1 235a 18.9 2277a
500 22.5b 442 238a 19.2  2519a
1000 22.0b 37.9 197b 17.1  1695b

ZNS, *, ** #*x #xx% Non-significant or significant at P=0.05, 0.01, 0.001, and 0.0001, respectively.

YLSD calculated as: LSD=t\/(2(EMS)/# obs. per mean) where t is determined at a=0.05 and df of error term. LSD is

used to compare within a row and within a column of the factorial treatment structure.

1f no LSD s is listed, different letters indicate that means are significantly different based on pair-wise

comparisons at 0=0.05.
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Table 2.5 Tissue concentrations of calcium and magnesium taken at the termination of the
Summer 2008 experiment (Day 74) of whole shoots and root medium pH and electrical
conductivity (EC) via saturated media extracts on three cultivars of ivy geranium grown under

three root medium water contents saturated, wet, or dry with either 0 or 200 mg-L™ supplemental

calcium.
Ca Mg
Concentration Concentration EC
(%) (%) pH  (dS/m)
Block NS* NS NS? NS
Cultivar falakaiel faakaked fakad NS
Water *kk*k *kkk *kk*k *

Calcium falakaiel NS NS NS
Cultivar*Water NS NS NS NS
Cultivar*Calcium NS NS NS NS
Water*Calcium * * NS NS
Cultivar*Water*Calcium NS NS NS NS

Cultivar*Water*Calcium

Cultivar - 'Amethyst 96'
Saturated Ca 3.81 0.34 4.9 1.18
No Ca 2.95 0.33 4.61 1.3
Wet Ca 3.91 0.33 474 1.33
No Ca 5.21 0.39 455 1.54
Dry Ca 3.53 0.47 5.32 1.34
No Ca 2.64 0.42 5.09 1.24

Cultivar - 'Lambada’

Saturated Ca 419 0.43 5.19 1.19
No Ca 3.58 0.44 4.97 1.2
Wet Ca 5.75 0.45 4.65 1.46
No Ca 8.65 0.5 4.85 1.34
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Dry

Cultivar - 'Sybil Holmes'
Saturated

Wet

Dry

Cultivar*Water
‘Amethyst-96°

‘Lambada’

‘Sybil Holmes’

Cultivar*Calcium
‘Amethyst-96’

‘Lambada’

‘Sybil Holmes’

Ca
No Ca

Ca
No Ca
Ca
No Ca
Ca
No Ca

Saturated

Wet
Dry

Saturated
Wet

Dry

Saturated
Wet

Dry
Ca
No Ca

Ca
No Ca

Ca
No Ca

3.43
3.15

5.04
7.17
12.4
8.55
5.09
4.22

3.38

4.56
3.09

3.88
7.2

3.29

6.1
10.47

4.66
3.75
3.6

4.45
5.13

751
6.65

43

0.51
0.51

0.4
0.42
0.44

0.5
0.63
0.56

0.34

0.36
0.45

0.39
0.47

0.51

0.41
0.47

0.6

0.38

0.38

0.46
0.48

0.49
0.5

5.11
5.33

5.3
4.96
4.74
5.39
5.65
5.81

4.76

4.64
5.2

5.08
4.75
5.22

5.13
50.7
5.73

4.99

5.06

4.99
5.05

5.23
5.38

1.37
1.2

1.23
1.06
1.49
1.42
1.49
1.2

1.24

1.43
1.29

1.2
1.4
1.29

1.14
1.45
1.34

1.29

1.36

1.35
1.25

1.4
1.22



Water * Calcium

Saturated Ca 4.35b 0.39c 513 1.2
No Ca 4.57b 0.40bc 4.85 1.18
Wet Ca 7.35a 0.40bc 4.71 1.43
No Ca 7.47a 0.46b 4.93 1.43
Dry Ca 4.02b 0.54a 5.36 1.4
No Ca 3.34b 0.50ab 5.41 1.21
LSDg 05" 1.34 0.06 NS NS
Cultivar
‘Amethyst-96’ 3.68¢” 0.38b 4870  1.32
‘Lambada’ 4.79b 0.47a 5.01b 1.29
‘Sybil Holmes’ 7.08a 0.49a 5.30a 1.31
Water Saturated 4.46b 0.39c
499 1.19ab
Wet 7.41a 0.43b 482b 1.43a
Dry 3.68¢ 0.52a 5382 1.30a
Calcium Ca 5.24a 0.44 5.07 1.34
No Ca 5.12b 0.45 5.06 1.28

ZNS, *, ** **x xx% Non-significant or significant at P=0.05, 0.01, 0.001, and 0.0001, respectively.

YLSD calculated as: LSD=tV(2(EMS)/# obs. per mean) where t is determined at a=0.05 and degrees of freedom of
error term. LSD is used to compare within a row and within a column of the factorial treatment structure.

*If no LSDg gs is listed, different letters indicate that means are significantly different based on pair-wise
comparisons at 0=0.05.
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Table 2.6 a and b. Tissue concentrations of calcium and magnesium taken at the termination of
the Fall 2008” (Day 77) experiment in the youngest, fully-expanded leaves and root medium pH
and electrical conductivity (EC) via saturated media extracts of ivy geranium grown under four

root medium water contents saturated, wet, optimal, or dry with either 0 or 300 mg-L™

supplemental calcium.

Ca Mg
Concentration Concentration EC
% % pH (dS/m)
Block NSY NS NS NS
Water NS NS NS *
Calcium * el NS *
Water*Calcium NS * NS NS
Water*Calcium
Saturated Ca 1.13 0.35¢ 4.54 0.77
No Ca 1.18 0.37c 4.65 0.56
Wet Ca 1.68 0.24d 452 0.59
No Ca 0.86 0.63a 3.38 0.3
Optimal Ca 1.41 0.31c 4.77 0.76
No Ca 1.26 0.43b 4.79 0.76
Dry Ca 1.36 0.38hc 4.67 0.86
No Ca 1.3 0.42b 471 0.55
LSDg g5 NS 0.05 NS NS
Water
Saturated 1.15 0.36 459 0.67a
Wet 1.27 0.43 3.95 0.45b
Optimal 1.34 0.37 4.78 0.76a
Dry 1.33 0.4 4.69 0.71a
Calcium Ca 1.40a" 0.32b 462  0.75a
No Ca 1.15b 0.46a 4.38 0.54b

Z Data means do not include the low VPD environment treatment
VNS, *, ** ***x ***x Non-significant or significant at P=0.05, 0.01, 0.001, and 0.0001, respectively.
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XLSD calculated as: LSD=t\(2(EMS)/# obs. per mean) where t is determined at 0=0.05 and degrees of freedom of
error term. LSD is used to compare within a row and within a column of the factorial treatment structure.

“1f no LSDg s is listed, different letters indicate that means are significantly different based on pair-wise
comparisons at 0=0.05.
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Table 2.6b Tissue concentrations of calcium and magnesium taken at the termination of the Fall
2008* experiment (Day 77) in the youngest, fully-expanded leaves and root medium pH and
electrical conductivity (EC) via saturated media extracts of ivy geranium grown under four root

medium water contents saturated, wet, optimal, or dry with either 0 or 300 mg-L™* supplemental

calcium.
Ca Mg
Concentration Concentration
% % pH EC (dS/m)
Block NSY NS NS NS
VPD NS NS NS NS
Water L * NS NS
Calcium * falahed NS **
VPD*Water NS NS NS NS
VPD*Calcium NS NS NS NS
Water*Calcium NS NS NS NS
Water*Ca*VPD NS NS NS NS
Water * Ca * VPD
VPD - High
Saturated Ca 1.13 0.36 4.54 0.77
No Ca 1.18 0.37 4.65 0.56
Wet Ca 1.68 0.24 4.52 0.59
No Ca 1.13 0.34 4.79 0.3
Optimal Ca 141 0.31 4.77 0.76
No Ca 1.26 0.43 4.79 0.76
VPD - Low
Saturated Ca 1.09 0.31 4,78 0.93
No Ca 0.94 0.3 5.21 0.38
Wet Ca 1.32 0.31 4.64 0.78
No Ca 1.23 0.39 4.67 0.49
Optimal Ca 1.48 0.36 4.69 1.03
No Ca 1.25 0.42 4.54 0.79
VPD*Water
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VPD-High

VPD-Low

VPD*Calcium
VPD-High

VPD-Low

Water*Calcium
Saturated

Wet

Optimal

VPD

Water

Calcium

Saturated
Wet
Optimal

Saturated
Wet
Optimal

Ca
No Ca
Ca
No Ca

Ca
No Ca
Ca
No Ca
Ca
No Ca

High
Low

Saturated
Wet

Optimal

Ca
No Ca

1.15
1.4
1.34

1.01
1.28
1.37

1.41

1.19
1.3

1.14

1.11
1.06
1.5
1.18
1.45
1.26

1.3

1.22

1.08b*
1.34a

1.35a

1.35a
1.17b

0.36
0.29
0.37

0.31
0.35
0.39

0.3
0.38
0.33
0.37

0.33
0.34
0.28
0.36
0.33
0.42

0.34

0.35

0.34b
0.32b

0.38a

0.31b
0.38a

4.59
4.65
4.78

4.99
4.65
4.61

4.61
4.74
4.7
4.8

4.66
4.93
4.58
4.72
4.73
4.66

4.67

4.75

4.79
4.65

4.69

4.65
4.77

0.67
0.45
0.76

0.66
0.64
0.91

0.71
0.54
0.91
0.55

0.85
0.47
0.69
0.4
0.89
0.77

0.62

0.73

0.66
0.54

0.83

0.81a
0.55b

? Data means do not include the low VVPD environment treatment

YNS, *, ** **x *xxx Non-significant or significant at P=0.05, 0.01, 0.001, and 0.0001, respectively.
*If no LSDy gs is listed, different letters indicate that means are significantly different based on pair-wise

comparisons at 0=0.05.
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Table 2.7 Averages of temperature and relative humidity as recorded with a HOBO data sensor

(Onset Computer Corp., Bourne, MA) every 30 min and vapor pressure deficits (VPD)

calculated using Murray’s equation (Murray, 1967).

Average Average
Temperature Relative Average VPD
(°C) Humidity (%) (kPa)

Day* NightY Day Night Day Night

Spring 2008* 28.6 20.1 40 52.7 3.06 1.37

Summer 2008" 284 256 674 665 142 113

Fall 2008"

Low VPD

Environment 23.3 15.1 60.4 76.7 1.14 0.39
High VPD

Environment 20.6 15.7 45.4 56.4 1.35 0.77

Spring 2009" 255 18.6 38.2 56.8 2.03 0.92

? Average of measurements from 0800 HR to 1730 HR
Y Average of measurements from 1800 HR to 0730 HR

*From 1 April to 30 May 2008

“From 28 June to 16 August 2008
YFrom 17 November to 18 December 2008
“From 5 March to 18 May 2009
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Table 2.8 Tissue concentrations of calcium and magnesium taken at the termination of the

Spring 2009 experiment (Day 90) of whole shoots and root medium pH and electrical

conductivity (EC) via saturated media extracts on three cultivars of ivy geranium grown under

three root medium water contents saturated, wet, or dry with either 0 or 200 mg-L™ supplemental

calcium.
Ca Mg
Concentration Concentration EC
(%) (%) pH  (dS/m)

Block NS? NS NS NS
Cultivar NS * * NS
Water *k,*k*k * *kkk *%

Ca|C|um *kkk *kk*k NS *kk*k
Cultivar*Water NS NS NS NS
Cultivar*Ca NS NS NS NS
Water*Ca * *% NS NS
Cultivar*Water*Ca NS NS NS NS

Cultivar*Water*Ca
Cultivar - 'Amethyst 96'

Saturated 0 1.03 0.33 494 2.18

500 1.25 0.32 489 3.62

1000 1.45 0.25 488 3.74

Wet 0 1.2 0.37 423 247

500 1.77 0.27 4.43 3.53

1000 2.11 0.24 444 381

Optimal 0 1.24 0.39 424 192

500 2.14 0.24 4.41 2.52

1000 2.45 0.17 433 345

Cultivar - 'Sybil Holmes'
Saturated 0 0.84 0.33 514 231
500 1.39 0.28 5.13 3.43
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Wet

Optimal

Cultivar*Water

‘Amethyst-96°

‘Sybil Holmes’

Cultivar*Ca
‘Amethyst-96°

‘Sybil Holmes’

Water*Ca

Saturated

Wet

1000

500
1000
0
500
1000

Saturated
Wet
Optimal

Saturated

Wet
Optimal

500
1000

500
1000

500
1000

500

0.41
0.75
2.06
1.78
1.2
1.85
2.43

1.24
1.69
1.94

0.88

1.53
1.83

1.15
1.72
2.01

0.93
1.67
1.63

0.93d

1.32¢c
0.99cd

0.98d
1.78b
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0.19
0.29
0.24
0.19
0.33
0.22
0.19

0.3
0.3
0.27

0.26

0.24

0.24

0.36
0.27
0.22

0.32

0.25
0.19

0.33ab

0.30b
0.22d

0.33ab
0.26bcd

5.07
3.94
4.33
4.34
4.66
451
4.66

4.9
4.36
4.32

5.11

4.2

4.61

4.47
4.58
4.55

4.59

4.66
4.69

5.04

5.01
4.97

4.08
4.38

4.87
2.43
2.94
4.13
1.79
2.47
2.46

3.18
3.27
2.63

3.54

3.16

2.24

2.19
3.22
3.66

2.18

2.94
3.82

2.24

3.52
4.3

2.45
3.23



1000 2.08b 0.21c 439 3.97

Optimal 0 1.22¢ 0.36a 445 1.85
500 1.99h 0.23cd 446 2.49
1000 2.44a 0.18d 45 295
LSDg o5 0.33 0.05 NS NS
Cultivar ‘ Amethyst-96° 1.63 0.292°  453b  3.02
‘Sybil Holmes’ 141 0.25b 4.64a 2.98
Water Saturated 1.06¢c 0.28a 5.0la 3.36a
Wet 1.61b 0.27ab 4.28b 3.21b
Optimal 1.88a 0.26b 4.47b 2.43b
Calcium 0 1.04c 0.34a 452 2.18c
500 1.70b 0.26b 4.62 3.08b
1000 1.82a 0.20c 462 3.74a

ZNS, *, ** **x sxxx Non-significant or significant at P=0.05, 0.01, 0.001, and 0.0001, respectively.

YLSD calculated as: LSD=tV(2(EMS)/# obs. per mean) where t is determined at a=0.05 and degrees of freedom of
error term. LSD is used to compare within a row and within a column of the factorial treatment structure.

*If no LSDg gs is listed, different letters indicate that means are significantly different based on pair-wise
comparisons at 0=0.05.
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Table 2.9 Edema development in the Summer 2008 experiment measured at the end of the
production period (Day 74) of three ivy geranium cultivars grown under three root medium water

content regimens; saturated, wet , or dry with either 0 or 200 mg-L™ supplemental calcium.

Affected
Edema Area %
Ratings (cm”2) Damage

Block NS NS NS
Cultivar NS NS falaie
Water NS NS *x
Calcium NS NS NS

Cultivar*Water NS NS *
Cultivar*Ca NS NS NS
Water*Ca NS NS NS
Cultivar*Water*Ca NS NS NS

Cultivar*Water*Ca
Cultivar - 'Amethyst 96'
Saturated Ca 3.5 8.0 1.18
No Ca 2.4 4.7 0.79
Wet Ca 2.8 5.0 1.28
No Ca 2.9 6.4 1.09
Dry Ca 3.3 9.5 2.76
No Ca 2.8 7.5 2.04
Cultivar - 'Lambada’
Saturated Ca 35 6.6 1.16
No Ca 2.5 5.6 0.90
Wet Ca 3.8 6.9 1.26
No Ca 3.1 9.2 1.18
Dry Ca 2.9 4.0 1.05
No Ca 3.0 3.9 1.16
Cultivar - 'Sybil Holmes'

Saturated Ca 2.9 4.1 0.63
No Ca 2.4 5.8 0.45
Wet Ca 2.9 8.1 0.69
No Ca 3.4 6.2 0.61
Dry Ca 3.1 6.3 1.28
No Ca 3.0 4.2 0.71

Cultivar*Water
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‘Amethyst-96°  Saturated 2.9 6.3 0.50b

Wet 2.8 5.7 0.70b
Dry 3.0 8.5 1.91a
‘Lambada’ Saturated 3.0 6.1 0.55h
Wet 3.4 8.1 0.73b
Dry 2.9 5.3 0.45b
‘Sybil Holmes” Saturated 2.6 49 0.06b
Wet 3.1 7.1 0.16b
Dry 3.1 5.3 0.50b
LSDg g5 NS NS 0.75
Cultivar*Ca
‘Amethyst-96° Ca 3.2 7.5 1.74
No Ca 2.7 6.2 1.31
‘Lambada’ Ca 3.4 5.8 1.16
No Ca 2.9 6.3 0.97
‘Sybil Holmes” Ca 2.9 6.2 0.86
No Ca 2.9 5.4 0.59
Water*Ca
Saturated Ca 3.3 6.2 0.99
No Ca 2.4 5.4 0.71
Wet Ca 3.1 6.7 1.08
No Ca 2.4 7.2 0.96
Dry Ca 3.1 6.6 1.69
No Ca 2.9 5.2 1.19
Cultivar ‘Amethyst-96’ 2.9 6.8 1.52a"
‘Lambada’ 3.1 6.1 1.06a
‘Sybil Holmes’ 2.9 5.8 0.73b
Water Saturated 29 5.8 0.55b
Wet 3.1 6.9 0.72b
Dry 3.0 59 1.14a
Calcium Ca 3.2 6.5 1.25
No Ca 2.8 6.0 0.96

ZNS, *, ** #*x *xxx Non-significant or significant at P=0.05, 0.01, 0.001, and 0.0001, respectively.
YLSD calculated as: LSD=tV(2(EMS)/# obs. per mean) where t is determined at 0=0.05 and df of error term. LSD is
used to compare within a row and within a column of the factorial treatment structure.
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Z1f no LSDg s is listed, different letters indicate that means are significantly different based on pair-wise
comparisons at 0=0.05.

Table 2.10 a and b Edema development in the Fall 2008 experiment measured at the end of the
production period (Day 77) of the ivy geranium cultivar ‘Amethyst 96 grown in a high VPD
environment under four root medium water content regimens: saturated, wet, optimal or dry with

either 0 or 300 mg:L™ supplemental calcium.

Affected
Edema Area %
Ratings (cm”"2) Damage

Block NSY NS NS

Water NS NS NS

Calcium NS NS NS

Water*Calcium NS NS NS
Water* Calcium

Saturated Ca 1.6 4.6 0.32

No Ca 1.6 5.2 0.54

Wet Ca 1.3 6.1 1.61

No Ca 1.3 7.3 0.42

Optimal Ca 1.8 8.5 0.72

No Ca 1.9 6.9 0.84

Dry Ca 1.6 7.9 1.25

No Ca 2.4 8.5 0.72

Water Saturated 1.6 49 0.43

Wet 1.3 6.7 1.01

Optimal 1.8 7.7 0.78

Dry 2.0 8.2 0.98

Calcium Ca 1.6 6.8 0.97

No Ca 1.8 7.0 0.63

? Statistical analysis does not include the low VPD environment treatment
YINS, *, **, *** “*** Non-significant or significant at P=0.05, 0.01, 0.001, and 0.0001, respectively.
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Table 2.10b Edema development in the Fall 2008 experiment measured at the end of the
production period (day 77) of the ivy geranium cultivar ‘Amethyst 96’ grown under three root
medium water content regimens: saturated, wet, or optimal in a high VPD or low VPD

environment with either 0 or 300 mg-L™ supplemental calcium.

Affected
Edema Area %
Ratings (cm”"2) Damage
Block NSY NS NS
VPD ** NS NS
Water NS NS NS
Calcium NS NS NS
VPD*Water NS NS NS
VPD*Calcium NS NS NS
Water*Calcium NS NS NS
VPD*Water*Calcium NS NS NS
VPD*Water*Calcium
VPD - High
Saturated Ca 1.6 4.6 0.32
No Ca 1.6 5.2 0.54
Wet Ca 1.3 6.1 1.61
No Ca 1.3 7.3 0.42
Optimal Ca 1.8 8.5 0.72
No Ca 1.9 6.9 0.84
VPD - Low
Saturated Ca 1.6 5.6 0.66
No Ca 2.6 7.0 0.63
Wet Ca 2.6 7.6 0.72
No Ca 2.3 7.2 0.56
Optimal Ca 2.3 7.5 0.54
No Ca 2.0 5.3 0.45
VPD*Water
VPD-High  Saturated 1.6 4.9 0.43
Wet 1.3 6.7 1.01
Optimal 1.8 7.7 0.78
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VPD-Low Saturated 2.1 6.3 0.65

Wet 24 7.4 0.64
Optimal 2.1 6.4 0.50
VPD*Calcium
VPD-High  Ca 15 6.4 0.88
No Ca 1.6 6.5 0.60
VPD-Low Ca 2.2 6.9 0.64
No Ca 2.3 6.5 0.55
Water* Calcium
Saturated Ca 1.6 5.1 0.49
No Ca 2.1 6.1 0.58
Wet Ca 1.9 6.8 1.16
No Ca 1.8 7.2 0.49
Optimal Ca 2.0 8.0 0.63
No Ca 1.9 6.1 0.65
VPD High 1.6b* 6.5 0.74
Low 2.2a 6.7 0.60
Water Saturated 1.9 5.6 0.54
Wet 1.8 7.0 0.83
Optimal 2.0 7.1 0.64
Calcium Ca 1.9 6.7 0.76
No Ca 1.9 6.5 0.57

? Statistical analysis does not include the dry root medium water content treatment

YINS, *, **, *** %% Non-significant or significant at P=0.05, 0.01, 0.001, and 0.0001, respectively.
*If no LSDg gs is listed, different letters indicate that means are significantly different based on pair-wise
comparisons at 0=0.05.
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Table 2.11 Edema development in the Spring 2009 experiment measured at the end of the
production period (Day 90) of two ivy geranium cultivars grown under three root medium water

content regimens: saturated, wet, or optimal with either 0, 500, or 1000 mg-L™ supplemental

calcium.
Affected
Area %
(cm”2) Damage
Block NS* NS
Cultivar NS NS
Water ** NS
Calcium NS NS
Cultivar*Water NS NS
Cultivar*Ca NS NS
Water*Ca NS NS
Cultivar*Water*Ca NS NS
Cultivar*Water*Ca
Cultivar - 'Amethyst 96'
Saturated O 153 4.92
500 395 11.81
1000 238 9.71
Wet 0 232 11.59
500 152 8.00
1000 174 10.28
Optimal 0 117 5.68
500 95 5.19
1000 100 6.24
Cultivar - 'Sybil Holmes'
Saturated O 413 13.55
500 150 5.19
1000 125 4.54
Wet 0 316 12.60
500 99 4.50
1000 107 6.20
Optimal 0 103 4.31
500 118 5.40
1000 93 7.54
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Cultivar*Water

‘Amethyst-96°  Saturated 262 8.81
Wet 186 9.96
Optimal 104 5.70
‘Sybil Holmes’  Saturated 229 7.76
Wet 174 7.77
Optimal 105 5.75
Cultivar*Ca
‘Amethyst-96° 0 167 7.40
500 214 6.68
1000 170 8.74
‘Sybil Holmes” 0 277 10.15
500 122 5.03
1000 109 6.09
Water*Ca
Saturated O 283 9.24
500 273 8.50
1000 181 7.12
Wet 0 274 12.09
500 125 6.25
1000 141 8.24
Optimal 0 110 4.99
500 107 5.29
1000 96 6.89
Cultivar ‘Amethyst-96’ 184 8.16
‘Sybil Holmes’ 169 7.09
Water Saturated 246a” 8.29
Wet 180ab 8.86
Optimal 104b 5.74
Calcium 0 222 8.77
500 168 6.68
1000 139 7.42

ZNS, *, ** #*x xxx Non-significant or significant at P=0.05, 0.01, 0.001, and 0.0001, respectively.
Y1f no LSDy g5 is listed, different letters indicate that means are significantly different based on pair-wise
comparisons at 0=0.05.
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CHAPTER 3 - Root Medium Water Content and Supplemental

UVB Light on Intumescence Development of Tomato

Introduction

Intumescence development is a physiological disorder of several greenhouse-grown crops
characterized by gall-like or protuberant growths typically found on leaf tissues. This disorder
has been known by several different names that are often used interchangeably: oedema (edema),
enations, genetic tumors, intumescences, neoplasms, and non-pathogenic galls. Two of these
terms, oedema and intumescences, are most commonly found in literature. Based on our
research, we believe there are two different disorders being described by these terms. We are
assigning the term intumescence development to the physiological disorder resulting in
individual cells swelling and bursting.

While mild symptoms of intumescence development may be tolerated, moderate to
severe symptoms include leaf chlorosis, leaf necrosis and leaf drop. This, along with the finding
that intumescence development lowers the number of chloroplasts in palisade cells (Eliza and
Dobrenz, 1971) may cause plants to grow slowly and have lower yields than unaffected plants
and will be severely affected aesthetically, resulting in economic loss in plant sales to consumers.

The exact environmental triggers of intumescence development are unknown. Previous
authors have suggested many possible factors that can lead to the development of intumescences.
Eliza and Dobrenz (1971) observed that oedema or intumescences of eggplant (Solanum
melongena L.) were induced in hot, humid environments within a plastic greenhouse and were
caused by hypertrophy (cellular swelling) of palisade cells which then ruptured the epidermal
layer. Air pollution was a probable cause in the development of enations on potatoes (Solanum
tuberosum L. ‘Russet Burbank’) grown in a growth chamber in according to Kirkham and
Keeney (1974). Petitte and Ormrod also found that air contaminants SO, and NO, had an effect
on intumescence development on potato, as well as propagation method. In this case, potatoes

(‘Russet Burbank,” ‘Norchip,” and ‘Kennebec’) propagated from a high carbohydrate source
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(tuber) generated more intumescences than potatoes propagated via stem cutting. However, Lang
and Tibbitts (1983) found air pollution to be an inconclusive cause on tomato plants (Solanum
lycopersicum var. esculentum L. ‘Oxheart’). In that same paper, relative humidity and radiance
levels did not have an effect on intumescence development, but temperature and ultraviolet
wavelengths did. Lang et al. (1983) performed an anatomical study and found similar results in
tomato as Eliza and Dobrenz (1971) in that palisade cells were hypertrophic, swelling to almost
double in size, and rupturing through the leaf epidermis. In sweet potato (Ipomoea batatas L.
Lam), a different anatomy of the disorder was described by Wetzstein and Frett (1984), where
both hypertrophy (cell swelling) and hyperplasia (cell proliferation) were evident within
mesophyll cells.

Jaworski et al. (1988) observed that intumescence development was highly dependent on
cultivar in Cuphea species and was not caused by insect predation. The removal of blue-green
light with a yellow filter was found to reduce the formation of intumescences of potato in a study
performed by Seabrook and Douglass (1998). This is contrary to a finding by Morrow and
Tibbitts (1988), where the addition of red light promoted intumescence development on potato,
while blue and green lights had no effect. Finally, a study by Pinkard et al. (2006) found that in
eucalyptus (Eucalyptus nitens Libill. and Eucalyptus globulus Deane and Maiden), intumescence
growth was actually the formation of lenticel-like structures on plant leaves as a result of high
relative humidity, which is a way to facilitate gas exchange.

When root medium water content resulted in no effects on intumescence formation, the
literature was re-evaluated and a possible link between ultraviolet (UV) wavelengths and
intumescence prevention was found. Several studies mentioned that this disorder occurred only
in controlled environments, such as greenhouses and growth chambers (Jaworski et al., 1987;
Kirkham and Keeney, 1974; Lang and Tibbitts, 1983; Lang et al., 1983; Petitte and Ormrod,
1986). Further, Lang and Tibbitts (1983) exposed tomato plants to the UV emissions of cool
while fluorescent lights in a growth chamber, effectively preventing intumescence development.

These reports lead to our study of the effects of UVB (280-320 nm) wavelengths on the
prevention of intumescences on two tomato cultivars, Solanum lycopersicum L. var. hirsutum
‘Maxifort’ and Solanum lycopersicum L. var. esculentum ‘Trust.” ‘Maxifort,” is used as a
rootstock in grafting tomatoes for disease resistance and was chosen for its extreme susceptibility
(Xin Zhao, University of Florida, Gainesville, personal communication, May 2008). ‘Trust’ was
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a used because it is a commercial variety that is indeterminate, like ‘Maxifort,” and was reported
to develop intumescences in high tunnels (Lewis Jett, West Virginia University, Morgantown
WV, personal communication, June 2008). Wavelengths in the B range of UV light were chosen
for this study because they are almost completely blocked by most greenhouse glazing materials,
unlike UVA (315-400 nm) which has some transmittance (Kittas and Baille, 1998) and is often
completely absent in growth chambers. We also investigated the effect of root medium water
content to see if it affected intumescence formation in tomato. For this work we again used
‘Maxifort,” the susceptible cultivar, but the resistant cultivar was ‘Florida-47’ (Xin Zhao,

University of Florida, Gainesville, personal communication, May 2008).

Materials and Methods
Two experiments were conducted to evaluate environmental effects on the occurrence
and development of intumescences. The first experiment evaluated the effects of root media
water content and was carried out from 26 March 2008 to 11 May 2008 on the cultivars
‘Maxifort’ and ‘Florida-47’. The second experiment evaluated the effects of ultra violet (UV)
light in the B wavelengths on the cultivars ‘Maxifort” and ‘Trust’ from 28 February 2009 to 27
March 2009 and included two runs (runs A and B) each containing a UV blocked and a UV

supplemented environment.

Plants and Growing Environment

In each experiment, two tomato (Solanum lycopersicum L.) cultivars were used:
‘Maxifort’ (var. hirsutum Humb. & Bonpl), ‘Florida-47’ and ‘Trust’ (var. esculentum Mill.).
Seeds were sown as plugs in soilless media (Fafard 2: Conrad Fafard, Inc., Agawam, MA) and
germinated under mist. Seedlings were fertilized with 50 mg - L* N from 20N-0.43P-16.6K
fertilizer (Peter’s 20-10-20 Peat-Lite Special, Scotts Co., Marysville, OH). For the first
experiment, seedlings were transplanted on 7 March 2008 (day 1) into nursery pots with
dimensions of 23 cm diameter x 24.5 cm depth and a volume of 10.2 L. In the second
experiment, plants were transplanted on 10 February 2009 (day 1) into pots with dimensions of
16.5 cm diameter x 11.5 cm depth and a volume of 730 ml. In both experiments, pots were filled

with peat-based, soil-less rooting medium (Fafard 2 Mix; Conrad Fafard, Inc., Agawam, MA).
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The plants were then grown in a 7.6 m x 7.6 m glass greenhouse in the Throckmorton Plant
Sciences range at Kansas State University, Manhattan, KS for the duration of the experiments.

In the first experiment, plants were fertilized with a controlled release fertilizer, 19N-
2.6P-9.9K (Osmocote 19-6-12, Scotts Co., Marysville, OH). A surfactant (Suffusion Granular;
OHP Inc., Mainland, PA) was applied to allow the peat-based media to re-wet. The fertilizer and
the surfactant were top-dressed on each pot at rates of 84 g/pot and 40 g/pot, respectively, on 25
March 2008 (day 19). The watering regime for the first experiment is described in the next
section. Plants were watered according to the root medium water status experiment described
below. In the second experiment, plants were fertilized with a pre-plant incorporation of triple
superphosphate (ON-19.7P-0K) at a rate of 0.6 g-L™. During the experiment, runs A and B were
fertilized 150 mg- L™ N from 15N-0P-12.5K (Jack’s Professional 15-0-15 Water Soluble
Fertilizer; JR Peters Inc., Allentown, Pa) applied at every watering.

In the first experiment, pest management consisted of releasing biological control agents
on 25 March 2008, which were Ambiyseius swirskii ((Athias-Henriot) Acarina: Phytoseiidae) and
Hypoaspis miles ((Berlese) Acarina: Hypoaspidae) to control thrips (Frankliniella occidentalis
(Pergande) Thysanoptera: Thripidae) and whiteflies (Bemisia argentifolii Bellows & Perring),
respectively. In the second experiment, plants in runs A and B were sprayed prior to the
experiment with a mixture of Azatin XL (Azadirachtin) (OHP Inc., Mainland, PA) and Pylon (4-
bromo-2-(4-chlorophenyl)-1-(ethoxymethyl)-5-(trifluoromethyl)-1H-pyrrole-3-carbonitrile)
(OHP Inc., Mainland, PA) on the first spray date, 24 February 2009, and Conserve SC
(Spinosad) (Dow AgroSciences, Indianapolis, IN) on the second spray date, 27 February 2009.
They were applied to control thrips and whiteflies.

Temperature was monitored using HOBO Environmental Monitors (Onset Comptuer
Corp., Bourne, MA). In the first experiment, air temperatures averaged 28.6°C during the day
and 20.1°C at night. In the second experiment, there were different air temperatures depending
upon whether or not UV light was blocked. In runs A and B air temperatures averaged 27.3°C
during the day and 22.9°C at night in the UV-blocked half of the UV apparatus and 27.8°C (day)
and 22.9°C (night) under the supplemented UV half of the apparatus.
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Scanning Electron and Dissection Microscopy Procedure

Scanning electron micrographs were taken on the abaxial surface of ‘Maxifort’ tomato
leaves in the Spring of 2009. Small pieces of leaf, approximately 75 mm? were glued onto a
scanning electron microscope (SEM) slide using a graphite emulsion. The slides were placed into
the scanning electron microscope (S-3500N Hitachi Science Systems Ltd., Hitachinaka, Japan)
and were rapidly cooled using liquid nitrogen to fix the samples. Micrographs were taken under
high vacuum using a backscatter detector (Robinson Detector ETP-USA/Electron Detectors Inc.,
Rocklin, CA)

A dissection microscope (Nikon SMZ1500; Nikon Corp., Kawasaki, Japan) with a digital
camera attachment (Nikon Digital Sight DS-5m; Nikon Instruments Inc., Melville, NY) was used
to photograph intumescences on the abaxial surface of tomato leaves at a magnification of 3X.

Root Medium Water Content Treatments

For the first experiment, two watering regimes, wet and dry, were established on the
tomato cultivars ‘Maxifort’ and ‘Florida-47’. In the wet treatment, plants were watered daily to
keep pots at container capacity, which in terms of weight was an average of 7.01 kg/pot, while
the air-dry weight of the container with media was 1.77 kg. In the dry treatment, pots were
weighed at the beginning of the experiment at container capacity to get a starting weight, which
was then used to determine the percent dry down between irrigations. The target percent dry
down was 40% water loss by weight which equaled an average mass of 2.72 kg. A 15% leaching
fraction was maintained for both water treatments. Leaching fractions were determined by
watering three, randomly chosen pots within the experiment with a known quantity of water.
Saucers were placed under those pots to collect the leachate. Once the leachate totaled 15% of
the total water applied, no more water was applied until the next irrigation and all other pots in
the experiment received the quantity of water determined by those three randomly assigned pots.

Water loss was measured by weighing representative pots in each treatment on a regular
basis, in conjunction with ECH,0O EC-5 probes (Decagon Devices Inc., Pullman WA). During
the first two dry down cycles, pots were weighed and probe readings were taken to correlate the
% dry down by weight to the probe readouts; the probes were then used to provide a rough

estimate of the % dry down. Once the probes began to give readings similar to those correlated

64



with the pot weights, pots were weighed to determine the exact dry down percentages in grams.

The probes gave the most exact watering dates without the need for daily weighing.

Establishing UVB Treatments

For the second experiment, two UV structures were built out of metal conduit arches
attached to an expanded metal greenhouse bench, each divided in half (Fig. 3.1). One half in
each UV structure blocked UV transmittance through the use of UV blocking greenhouse plastic
(DuraGreen EM 3 Years OF D7/11 by DuraGreen Marketing USA, Mount Dora, FL) attached to
the metal conduit structure (UV blocked treatment). The other half did not have the UV blocking
plastic between the plants and the UV light source (UV supplemented treatment).

For this experiment, we decided to focus on UVB (280-320 nm) as opposed to UVA
(320-400 nm) and UVC (100-280 nm) because UVB is often blocked in greenhouse glazing
materials, unlike UVA, and is less harmful to living cells than UVC. The UVB light source in
both UV structures consisted of six UV transmitting fluorescent light tubes (UVB-313 lamps
from Q-Lab Westlake, OH). These lights emitted wavelengths from 250 nm to 400 nm, but had
the highest irradiance in the 290-340 nm range — fulfilling our requirements for testing UVB
(280-320nm) specifically. Protective equipment was worn to protect researchers from exposure
to UV-light, which included UV-resistant goggles and face masks, nitrile gloves, and lab coats.
These tubes were placed in three fluorescent light fixtures (122 cm long) which were then hung
from metal conduit using chain 87.6 cm above the expanded metal bench upon which plants
were placed. Plastic light diffusers (Styrene Prismatic Clear 2’x 4’ by Plaskolite, Columbus, OH)
with dimensions of 61 cm x 122 cm were installed 9 cm below the lights (78.8 cm above the
bench surface). The diffusers served to prevent sunburn of plant tissues by diffusing and
scattering the light, while still transmitting UVB wavelengths. The UV light source was shared
by both halves of each structure— the area directly beneath the lights and diffusers was separated
in half, with one half covered with the UV block plastic, the other left open to receive the UV
wavelengths. This gave both halves of the UV structure an effective treatment area of 123.2 cm
(width of the bench) by 61 cm (one half of a 48’ (122 cm) long fluorescent light tube) or 7515.2
cm2.

The UV blocked half of each structure was constructed of UV blocked plastic attached to

the metal conduit. The plastic was stretched to make a surface covering the width of the bench
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(123.2 cm) with a length of 121.9 cm and was held 68 cm above the bench surface. The effective
area of the UV blocked treatment, where the plants were placed in the structure, ran from the
middle of the fluorescent light tubes out to a distance of 61 cm. The UV supplemented side had
nothing except the light diffusers between the plants and the UV light source, with the effective
area of the UV supplemented treatment running from the middle of the light tubes again to a
distance of 61 cm away. The treatments were separated by a piece of UV blocking plastic
connected to the top of the UV blocking plastic surface from the UV blocked treatment down to
the bench surface along the full bench width and was situated directly under the midpoint of the
fluorescent light tubes. All other sides of the treatments were left open to allow air movement
through the apparatus.

Additionally, a baffle made of the UV block plastic 48.3 cm wide was run along the
perimeter of the UV apparatus. It served to keep air movement similar between the two halves of
the UV apparatus and as a safety precaution for the researchers. It was attached perpendicular to
the UV blocking surface at the height of the surface and was run along the whole perimeter,
which allowed the UV supplemented treatment to get similar air movement to the UV blocked
treatment. The baffle was wide enough that the UV lights could not directly transmit
wavelengths to researchers, unless directly under the lights in the UV supplemented treatment,
acting as a safety mechanism.

The UV lights were on 12 hrs each day, from 0700 HR to 1900 HR daily. UV light was
monitored on a weekly basis in all sections of the UV structure using a Field Scout 3414
Ultraviolet Light Meter (Spectrum Technologies Inc., Plainfield, IL) (Fig. 3.2). Another UV-
instrument (Mannix UV-340 UV Light Meter (General Tools and Instruments Co. New York,
NY) was also used to monitor UV light, with data given in Appendix D.

Intumescence Characterization
Intumescences in the first experiment were characterized several times per week by
taking ratings of three pre-chosen leaves at three different stages of tomato development. In
addition, percent leaf area damaged was estimated after studying a software program
(Disease.Pro; written by Nutter, F.W., O. Worawitlikit, and D. Litwiller; Dept of Plant
Pathology, lowa State University, Ames, IA; Available for purchase by contacting F.W. Nutter
315 Bessey Hall, lowa State University, Ames, 1A 50011) which allows researchers to train
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themselves in assessing leaf area damaged. The program is designed to train plant pathology
students in recognizing foliar area damaged of peanut (Arachis hypogaea L.) crops. Leaf ratings
were on a scale of zero to ten, with a score of zero representing no intumescence development, a
five representing widespread intumescence development over the entire leaf with little to no
necrosis, and a ten representing the necrosis of the entire leaf due to succumbing to
intumescences.

In the second experiment, intumescences were tracked on a leaflet basis. Each leaflet was
looked at several times per week. Whether a leaflet had a single intumescence or several, it was
noted as being affected by intumescences and the total number of leaflets affected for each leaf

was recorded.

Growth Data at Harvest
Plants in the first experiment were harvested on 11 May 2008 (day 47). Plants in runs A
and B of the second experiment were harvested on 27 March 2009 (day 28). In both
experiments, plant heights, shoot fresh weights, and shoot dry weights were determined at
harvest. Plant heights were measured from the root medium surface to the top of the foliage
canopy. Dry weights were measured after plants were dried at 70°C in a forced-air oven for

several days.

Statistical Procedures
The first experiment was a completely randomized design with two water status
treatments (wet and dry) and two cultivars. The second experiment was a split plot design with
the whole plot being the two UV light treatments (blocked and not blocked) with cultivar as the
subplot.
Analysis of variance was conducted on both experiments using PROC GLM and PROC
MIXED in SAS version 9.1.3 (SAS Institute Inc., Cary, NC).

Results and Discussion

Scanning Electron Microscope (SEM)
Because the tomato ‘Maxifort’ showed intumescence damage, and ‘Trust” and ‘Florida-
47’ did not, dissection and scanning electron micrographs were taken on the leaves of
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‘Maxifort.” In Fig 3.3, epidermal cells are swollen and protruding resulting in the intumescence
found on the leaf surface.The pictures showed epidermal cells swelling to extreme sizes in non-
necrotic intumescences (Fig 3.4). In the micrograph, the normal, unaffected cells (A) look like
puzzle pieces and are approximately 25-50 um in diameter. The cells involved in the
intumescence development (B) are much larger, with diameters approximately 50-75 um and are
no longer shaped as puzzle pieces. As the intumescences mature over time, the swollen
protoplasts burst, leaving large areas of cell wall structures which remain and form the necrotic
regions associated with mature intumescences (Fig. 3.5). As noted in the Introduction,
intumescences have been stated to be the result of hypertrophy or hyperplasia. Hypertrophy is
the abnormal enlargement of a cell, while hyperplasia is an abnormal multiplication of cells. The
finding that the Maxifort tomato cells burst agrees with those who state that intumescences are
caused by hypertrophy (Lang et al., 1983; Wetzstein and Frett, 1984), but it does not agree with
those who state that it is caused by hyperplasia (La Rue, 1933).

Effects of Root Medium Water Content Treatments

As noted in Materials and Methods, the effect of water on the development of
intumescence development was studied on ‘Maxifort” and ‘Florida-47’ during the spring of
2008. The data showing intumescence damage are given in Table 3.1. This damage, as
determined by the subjective visual percentage affected described above, was significant at the
0.05 level (Table 3.1) for the water factor, suggesting that root medium water content may have a
role in intumescence development based on visual observation. These data must be interpreted
with caution because the method of determining leaf area that was damaged by intumescences
was qualitative. It was impossible to distinguish damage due to intumescences and damage due
to drought (i.e., chlorosis) Lang et al. (1983) found no evidence that water-soaked tissues were
the cause of intumescences on tomato.

The data for vegetative growth from the spring 2008 experiment are shown in Table 3.2,
and the data for yield from this experiment are shown in Table 3.3. For an unknown reason, root
medium water content did not have an effect on plant growth in this experiment, measured in
terms of plant height, fresh weight and dry weight (Table 3.2), or on tomato yields as determined
by overall fruit counts and fresh weights (Table 3.3). Plant growth and fruiting were significantly

different between ‘Maxifort’ and ‘Florida-47’ with ‘Florida-47’producing an average of 16 fruits
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per plant with a total fresh yield of 533.5g per plant and with an average height of 63.5 cm while
‘Maxifort’ produced an average 7 fruits with a total fresh yield of 2.2 g per plant and with an
average plant height of 164.3 cm. Despite these differences, the total fresh and dry weights of the
two cultivars were not significantly different. ‘Maxifort’ is an indeterminate disease-resistant
rootstock. ‘Florida-47’ is a determinant cultivar commercial fruiting cultivar. It is because of
these traits that ‘Maxifort’ was much greater in height, but not in fresh or dry weights, because of
its open, sparse, growth and small, underdeveloped fruits compared to ‘Florida-47" which had

bushy, lush growth and full, ripening fruits (Fig. 3.6).

Effects of UVB Light Treatments

As noted in Materials and Methods, experiments to study the effect of UV light on
intumescence formation on the cultivars ‘Maxifort” and ‘Trust’ were done in the spring of 2009.
Growth results (Table 3.4) show ‘Maxifort” was taller than ‘Trust,” at 65.3 cm and 52.1 cm,
respectively, and had more above-ground dry weight with 16.7 g compared to ‘Trust’ at 13.8 g.
Trust did not develop intumescences with UV light or when it was filtered out. UVB light
supplementation had a significant effect in the prevention of intumescence development on
‘Maxifort’ (Table 3.4). The ‘Maxifort’ plants receiving the supplemented UV had a very low rate
of intumescence development with an average of 11.9% of the total number of leaves being
affected in the UV supplemented treatment compared with 60.5% leaves affected by
intumescence development in the UV blocked treatment (Table 3.5).

A dimension of the tomato UVB experiment was to determine when intumescences
developed on the susceptible ‘Maxifort’ plants. To determine this, the percentage of leaflets
affected with intumescence development out of all leaflets on true-leaf 7 was tracked over the
course of the experiment.

As seen in Figures 3.7 and 3.8, intumescence development on leaf 7 began on 11 March
2009 (day 12) for Run A and 13 March 2009 (day 14) for Run B. Development leveled off from
17 Mar. 2009 (day 18) to 20 Mar. 2009 (day 21) for Run A and 13 Mar. 2009 (day 14) to 20
Mar. 2009 (day 21). Development increased again for both run from 23 Mar. 2009 (day 24) until
the termination of the experiment on 27 Mar. 2009 (day 28). The second increase in
intumescence development could be the result of cloudy days observed around 20 Mar 2009,

decreasing overall ambient UV levels. The leaves that did develop intumescences were low in
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the canopy and were likely being shaded from the full UV effect from leaves in the upper
canopy. Leaves in the UV supplemented treatment did not develop intumescences until 24 days
after the experiment began.

Plants in the UV-supplemented treatment had some intumescence development at the end
of the experiment. This could be due to shading of the leaves by the upper canopy, reducing the
UVB light to the leaves. It could also be due to the cloudy days recorded around 20 March 2009.
While the UV levels were statistically different on this day between the UV-supplemented and
UV-blocked treatments, the UV-supplemented levels of UV light were closer to those normally
found in the UV-blocked treatment on brighter days. The differences in intumescence
development between runs might be explained by the age of the UV-emitting lights. Run B had
lights that were not used for three months while the lights in run A were running for preliminary
studies.

As an area for further study, we believe that there might be a threshold mechanism at
work where, if a plant susceptible to the development of intumescences receives a certain
amount or intensity of UV light, intumescence development may be prevented. This could
explain why leaves in the lower canopy began developing intumescences as the plants aged, as
leaves in the upper canopy were shading the lower leaves, preventing the optimal levels of UV
light from getting to the leaf tissues. Further study of this proposed mechanism should be
undertaken and the threshold intensity of UV light for intumescence-prevention needs to be
determined.

These results concur with those of Lang et al. (1983). They added UV radiation to a
growth chamber by the use of cool-white fluorescent lighting. This also lends credence to those
researchers who have noted that intumescence development occurred only in controlled
environments (Jaworski et al., 1987; Lang and Tibbitts, 1983; Petitte and Ormrod, 1986; Pinkard
et al., 2006; Wetzstein and Frett, 1984). This result suggests that cultivars susceptible to this
disorder would likely have better yields due to an increase in photosynthetic area if grown

outdoors or in environments were UV light can be supplemented economically.
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Figure 3.1 Photograph of the UV structure containing the UVB Blocked treatment (A) and the
UVB supplemented treatment (B). Plants were placed on an expanded metal bench (C) with
metal conduit (D) allowing attachment of UV-absorbing plastic (E) to create a barrier between
the two treatments and between the blocked treatment and the UV-emitting lights (F). Plastic
light diffusers (G) were placed between the UV-emitting lights and both treatments to prevent
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sunburn and a baffle (H) made out of the UV-absorbing plastic to equalize air-flow between the
treatments and to provide added safety to researchers. For the UV experiment discussed in this
chapter, the UV-absorbing plastic and plastic light diffusers were raised up to a position directly
under the UV-emitting lights to provide room for the tomatoes’ heights. In the preliminary UV
experiments in Appendix C the UV-absorbing plastic was at the height shown and no plastic

diffusers were used.

40

UV Light Levels by Treatment

—&— UV Blocked
~li— UV Supplemented

UV Light Intensity (umol m-25s-1)

Figure 3.2 Graph of UV intensity as determined using a Field Scout 3414 Ultraviolet Light
Meter (Spectrum Technologies Inc., Plainfield, IL) taken weekly from 6 weeks prior to the start
through the termination of the Spring 2009 UV light experiment. The wavelengths measured

with this meter ranged from 250-400 nm, reporting a broad spectrum of UV wavelengths.
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Figure 3.3 Dissection micrograph of an intumescence on the abaxial surface of a ‘Maxifort’

tomato leaf. A: Intumescence cell exhibiting extreme swelling; B: Trichome; C: Unaffected cells.
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Figure 3.4 Scanning electron micrograph of the abaxial surface of a tomato leaf showing area

affected by intumescence development. A: Unaffected cell; B: Intumescence cells exhibiting
extreme swelling; C: Stomate; D: Trichome; E: Detector type backscatter electron; F: Date
taken; G: Magnification 70X; H: Scale: 500 um from the first square to the last square on the

scale bar
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Figure 3.5 Scanning electron micrograph of the abaxial surface of a tomato leaf showing

necrotic area affected by intumescence development. A: This area depicts the empty cell walls
left after intumescence cells burst; B: Intumescence cell prior to bursting; C: Unaffected cell; D:
Stomate; E: Type of scan: backscatter electron; F: Date taken; G: Magnification 90X; H: Scale:
500 um from the first square to the last square on the scale bar
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Figure 3.6 Comparison of ‘Maxifort’ (foreground) and ‘Florida-47’ (background) growth

by SAGA

characteristics. ‘Maxifort’ has an open, tall growth habit as seen on the left, while ‘Florida-47’
has a compact growth habit, resulting in differences in growth. Also seen in this photo,
‘Maxifort” was severely affected by intumescence development, while ‘Trust’ was not affected at

all.
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Figure 3.7 Percent leaflets affected by intumescences on ‘Maxifort’ tomato plants in the Spring
2009 UVB experiment. Percent leaflets affected were obtained from all ‘Maxifort’ plants in run

A on true leaf number 7 over the course of the experiment.
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Figure 3.8 Percent leaflets affected by intumescences on ‘Maxifort’ tomato plants in the Spring
2009 UVB experiment. Percent leaflets affected were obtained from all ‘Maxifort’ plants in run

B on true leaf number 7 over the course of the experiment.
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Table 3.1 Intumescence damage at the end of the production period (day 67) of two tomato
varieties, var. esculentum ‘Florida 47’ and var. hirsutum ‘Maxifort’ grown in either a wet or dry

root medium water content environment in the Spring 2008 root medium water content

experiment.
% Damage
(by sight)
Cultivar ekl
Water *
Cultivar*Water *
Cultivar*Water
Florida 47 Dry 1.0c
Wet 2.0c
Maxifort Dry 28.0b
Wet 44.0a
LSDg o5 7.0
Cultivar
Florida 47 1.0pY
Maxifort 36.0a
Water
Dry 14.0b
Wet 23.0a

ZINS, *, ** *** **xx Nop-significant or significant at P=0.05, 0.01, 0.001, and 0.0001, respectively.
YIf no LSDy s is listed, different letters indicate that means are significantly different based on pair-wise
comparisons at 0=0.05.
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Table 3.2 Growth characteristics at the end of the production period (day 67) of two tomato

varieties, var. esculentum ‘Florida 47,” and var. hirsutum ‘Maxifort,” grown in either a wet or dry

root medium water content environment in the Spring 2008 root medium water content

experiment.
Height Fresh Weight ~ Dry Weight
(cm) (9) (9)
Cultivar falakalel NS NS
Water NS NS NS
Cultivar*Water NS NS NS
Cultivar * Water
Florida 47 Dry 62.0 402.5 46.9
Wet 65.0 570.8 56.2
Maxifort Dry 153.3 494.0 68.7
Wet 175.3 719.8 82.7
Cultivar
Florida 47 63.50” 486.6 515
Maxifort 164.3a 606.9 75.7
Water
Dry 107.6 448.3 57.8
Wet 120.1 645.3 69.5

ZINS, *, ** *** **xx Nop-significant or significant at P=0.05, 0.01, 0.001, and 0.0001, respectively.
YIf no LSDy s is listed, different letters indicate that means are significantly different based on pair-wise

comparisons at 0=0.05.
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Table 3.3 Fruit yield at the end of the production period (day 67) of two tomato varieties, var.
esculentum ‘Florida 47” and var. hirsutum ‘Maxifort,” grown in either a wet or dry root medium

content environment in the Spring 2008 root medium water content experiment.

Total Fruit Fruit Fresh
Number  Weight (g)

Cultivar *? Fokkk
Water NS NS
Cultivar*Water NS NS
Cultivar*Water
Florida 47 Dry 15 355.0
Wet 17 712.0
Maxifort Dry 10 2.4
Wet 5 2.0
Cultivar
Florida 47 16a” 533.5a
Maxifort 7b 2.2b
Water
Dry 13 178.7
Wet 11 357.0

ZINS, *, ** *** **xx Nop-significant or significant at P=0.05, 0.01, 0.001, and 0.0001, respectively.
YIf no LSDy s is listed, different letters indicate that means are significantly different based on pair-wise
comparisons at 0=0.05.
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Table 3.4 Growth characteristics at the end of the production period (day 46) of two tomato
varieties, var. hirsutum ‘Maxifort,” and var. esculentum ‘Trust,” grown in either a wet or dry root

medium water content environment in the Spring 2009 UVB light experiment.

Fresh Dry
Height  Weight Weight
(cm) (9) (9)
Run NS? * NS
Cultivar ** NS *x
UV Treatment NS NS NS
Cultivar*UVv NS NS NS
Cultivar*uv Maxifort No UV 63.3 156 16.5
uv 67.4 154 16.8
Trust No UV 52.8 137 12.6
uv 51.4 157 15.1
UV Treatment No UV 58.0 147 14.6
uv 59.4 156 15.9
Cultivar Maxifort 65.3a" 155 16.7a
Trust 52.1b 147 13.8b

ZINS, *, ** *** **xx Nop-significant or significant at P=0.05, 0.01, 0.001, and 0.0001, respectively.
Y1If no LSDy s is listed, different letters indicate that means are significantly different based on pair-wise
comparisons at 0=0.05.
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Table 3.5 Intumescence damage at the end of the production period (day 46) on two tomato
varieties, var. hirsutum ‘Maxifort’ and var. esculentum ‘Trust’ grown in either a wet or dry root
medium water content environment in the Spring 2009 UVB light experiment.

Total % Total
Leaves Leaves Leaflets % Leaflets
Affected Affected Affected Affected

Run NS* NS NS *
CU|tIV8.I’ **kk*k **kk*k *kk*k **kkk
UV Treatment **k*k%k **k*k%k **kk*k ***k*k
Cultlvar*UV **kk*k **kk*k *kkk **kkk
Cultivar*uVv Maxifort No UV 8.3 60.5 395 23.4

uv 15 119 3.6 2.2

Trust No UV 0 0 0 0

uv 0 0 0 0
UV Treatment No UV 4.1aY 30.3a 19.8a 11.7a
uv 0.8b 6.0b 1.8b 1.1b
Cultivar Maxifort 4.9a 36.2a 21.6a 12.8a

Trust Ob Ob 0b Ob

ZINS, *, ** *** **xx Nop-significant or significant at P=0.05, 0.01, 0.001, and 0.0001, respectively.
Y1If no LSDy s is listed, different letters indicate that means are significantly different based on pair-wise
comparisons at 0=0.05.
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Appendix A - Root Medium Nutrition over Time

Calcium Concentration in Root Medium Solution
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Figure A.1 Average calcium concentration in the supplemental calcium treatments’ root media
solutions taken using the pour-through method in the Spring 2009 experiment. A full experiment
root media leach occurred on 10 April 2009 (Day 52).
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Figure A.2 Average pH in the supplemental calcium treatments’ root media solutions taken
using the pour-through method in the Spring 2009 experiment. A full experiment root media
leach occurred on 10 April 2009 (Day 52).
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Appendix B - Details of Scanning Procedures used to Quantify

Edema

All leaves from every plant in the Summer 2008, Fall 2008 and Spring 2009 experiments
with ivy geraniums were scanned into bitmap (.bmp) files (example: “treatment.bmp”) at a high
resolution of 600 dots per inch (dpi) against a white background. The scanner used was an Epson
Perfection 4490 Photo (Seiko Epson Corp., Nagano, Japan) flatbed scanner. Two different
methods were used to quantify edema damage on the leaves depending on whether the edemata
had formed necrotic callused lesions (Summer and Fall 2008; ‘Color Range Method’) or whether
the edemata were similar in color to the leaf tissue (Spring 2009; ‘Lasso Method’). The ‘Color
Range Method’ used the color range feature of Adobe Photoshop 7.0 (Adobe Systems Inc., San
Jose, Ca). The ‘Lasso Method’ used the Lasso tool in Photoshop to outline and remove areas of
damaged oedema that the color range was unable to pick up. Both are useful, but have
drawbacks. The Color Range Method is not useful if the damage is the same color as other leaf
tissues, but allows for overall damage to be quantified. The Lasso Method does not rely on
specific colors, but on human recognition of damage and gives an analysis of area affected but

requires significantly more time to process.

Color Range Method
A color range to outline and remove damaged areas was created by opening a test scan
with oedema damage in Adobe Photoshop. The steps are as follows:
1. Select a Color Range
a. Open the scan in Adobe Photoshop
b. Zoom in on a damaged area close enough to see individual pixels
c. Select “Select” > “Color Range” in the upper toolbar
i. The Color Range box will appear; to begin selecting the damaged areas,
select the box with the eyedropper and the + sign

ii. Run the eyedropper tool over damaged areas
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1. Select pixels either by left clicking on individual pixels or by
holding down the left mouse button and running the eyedropper
over a damaged area

iii. To reduce the amount of unintended pixels being selected, decrease the
“Fuzziness” which is located in the Color Range box, near the top
iv. As pixels are selected from the damaged area, check the black-and-white
image in the color range box as it is a good indicator of the areas being
selected for ultimate removal
2. Once the color range is set, save it by using the “Save” button in the color range box
a. It usually requires multiple color ranges and two to three test scans to optimize the
range for the treatment scans; however, once chosen, only one range should be
used for an entire experiment
Once an appropriate color range has been selected, the oedema on the treatment scans can
be eliminated via whiting the areas out, leaving whitespace which can then be analyzed by
software. Procedures to remove the damaged tissue are as follows:
1. Open the treatment scan in Adobe Photoshop
2. Apply the Color Range saved from the last steps
a. To open a Color Range, go to “Select” > “Color Range;” in the color range box,
click the “Load” button and find the color range previously saved and tested; hit
OK
b. This will cause areas on the leaves to be surrounded by moving dotted lines; these
lines should be enclosing the damaged areas. If they are not and if a significant
amount of undamaged tissue is included, a new color range should be established
3. White out the enclosed areas by selecting “Edit” > “Fill.” A Fill box will appear; in the
drop down “Use:” menu at the top, select “White”, and hit the OK button on the side
a. All of the areas selected from the color range will now be white and the scan will
look like the damage has been cut out
4. Save the new white-holed image as a Tiff file (.tif) — example filename: “treatment-
white.tif”
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With the damage now removed and white holes in its place, the scans can now be opened
into Scion Image, where analysis on leaf area and damaged area can be performed. However, our
scans were too big for Scion to handle which resulted in the program crashing, so the white-
holed images’ resolution was reduced to 75 dpi in Photoshop prior to opening them in Scion. To
reduce the resolution (and thus the file size) in Photoshop:

1. Open the white-holed image
2. Select “Image” > “Image Size;” the Image Size box will pop up; in the “Resolution”
numeral box, reduce the resolution to 75 dpi or other appropriate level
a. This step resulted in the added advantage of reducing the amount of “noise”
(pixels of undamaged tissue) from the color range as individual pixels from the
high resolution are eliminated and are condensed together when the scan is saved
at the lower resolution
3. Save the reduced image as a .tif file (example: “treatment-white-resize.tif”)
Now Scion Image can be used to analyze the scans for leaf area and damaged area.
1. Open Scion Image
2. Increase the “Undo and Clipboard Buffer” size by selecting “Options” > “Preferences”
from the upper toolbar and putting 99999 in the numeral box
a. This allows for larger file sizes to be used
b. The program will indicate that Scion Image must be restarted for the changes to
take place; however, this is neither necessary nor recommended. In our
experience, Scion did not save this preference, so it was lost every time Scion was
closed.
3. Open the white-holed treatment file in Scion Image
a. Two copies of the image will come up, one color and one grayscale; close the
color image, as the grayscale image will be used for analysis
4. Threshold the image
a. In the upper toolbar: “Options” > “Threshold” the threshold image will be black
and white with the damaged areas showing as white and the normal tissue
showing as black — this is necessary for the program to run the analyses

5. Set the scale to a useful unit
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a. In the upper toolbar: “Analyze” > “Set Scale” then choose the units you wish to
use in the drop down “Units” menu
I. Pixels were used in our work because it is the smallest unit possible,
reducing rounding errors, and could later be converted to cm? using the
resolution (example: 75 dpi = 75 pixels/inch; so (total pixels/75%)*2.54% =
cm?)
b. This “Set Scale” step must be repeated every time a new image is opened
6. Analyze the total leaf area
a. In the upper toolbar: “Analyze” > “Analyze Particles” -- the “Particles Analysis
Options” box will appear; check the boxes labeled “Outline Particles,” “Include
Interior Holes,” and “Reset Measurement Counter”
I. This often changes the image; undo the changes by selecting “Undo
Editing” in the “Edit” menu of the upper toolbar and re-threshold the
image
b. Go back to “Analyze” in the upper toolbar and select “Show Results”
I. A box will pop up giving the total pixels in each ‘particle;” copy results in
this box and paste them into a spreadsheet
1. Along with the total pixels, mean density is also reported; this
feature was not used and can be removed from the area box by
going to “Analyze”> “Options” and un-checking the box marked
“Mean Density” — you only have to do this once each time Scion is
opened
7. Analyze the leaf area without the damaged areas
a. This is almost exactly the same as step 6, only this time in the “Analyze Particles”
box, uncheck “Include Interior Holes”
b. Again, copy results in this box into a spreadsheet for further analysis
8. Analyzing the results
a. With the information now in the spreadsheet, getting the percent damaged area is
as simple as adding up the pixels from both versions of the scans (the column

with the interior holes counted and the column with the interior holes not counted)
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then dividing the sum of those without interior holes by the sum of those with
interior holes, subtracting the number from one and multiplying by 100:
I. % Damage = 1-(area with damage removed/area without damage
removed)*100

Lasso Method

1. Open the scan to be analyzed in Adobe Photoshop
a. Select the Lasso tool on the left-hand tool bar
i. The tool looks like a little lasso, or a comic text bubble
b. Use the Lasso tool by clicking and dragging the mouse around the affected area
i. To select multiple areas, hold down the shift key before and during each
selection
c. Once all of the damaged areas on all of the leaves on the scan have been selected,
copy them by using Ctrl C (the control key plus the C key on your keyboard)
d. Open a new project
I. Click on “File” > “New” in the upper tool bar
ii. Name the project something like “treatment-cutout”
e. Copy the cutouts of the affected area onto the new project by using Ctrl V (the
control key plus the V key on your keyboard)
f. Save the project
i. Save the file using “Save As” function
1. The file type should be a TIFF (.tif)
2. Use a slightly different name than the original scan; example:
treatment-cutout.tif
g. As with the Color Range Method, the image size will need to be reduced to work
in Scion
I. In this method, both the original and the “cutout” files will need to be
reduced following the aforementioned method
1. Remember, if the originals will be kept as they were, do a “Save

As” and save with a different name (treatment-resize.tif for
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example), otherwise your originals will be reduced in size and it

might be difficult to use in the future

2. Analyze the scan using Scion

a. Open the original scan (reduced in size) in Scion

Set the scale to pixels or other units of choice
1. In the upper toolbar: “Analyze” > “Set Scale” then choose the units
using the drop down “Units” menu
Set up the analysis the program will run by following “Analyze”>
“Options” and un-checking the box marked “Mean Density;” you only
have to do this once each time Scion is openedThreshold the image:
“Options” > “Threshold”
Run the analysis: “Analyze” > “Analyze Particles”
1. Make sure “Include Interior Holes” and “Reset Measurement
Counter” are checked and click OK
a. This will cause the image to look like the leaves
disappeared and are outlined in grey, which is supposed to
happen
Access the analysis by “Analyze” > “Show Results”
1. This will bring up a window with a column of numbers; use Ctrl C

to copy this column and paste it into a spreadsheet

3. Analyze the “cutout” scan following these exact same directions

a. Instead of Scion running an analysis with and without the white space within the

leaves being counted and analyzed, the “cutout” version of the original scan

replaces the scan with white space from the ‘Color Range Method’
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Appendix C - Preliminary UVB Experiments and Intumescence Age

Effects on ‘Maxifort’ Tomato

Preliminary UVB Experiments

Spring 2008 Geranium UVB Experiment

UVB fluorescent lighting was set 33.5 cm above the height of the bench with the UV-
absorbing plastic of the UV-blocked treatment set directly underneath. Otherwise, the apparatus
set-up was the same as mentioned in the Materials and Methods in Chapter 2 of this thesis. The
plants included three cultivars of ivy geranium (Pelargonium peltatum L’Herr ex. Ait.),
‘Amethyst 96,” ‘Lambada’ and ‘Sybil Holmes.’

This experiment began on 21 April 2008 (day 1). Within five days (25 April 2008, day
5), plants in the UV-supplemented treatment were turning “tan” (sunburn) with the effects of the
UV lights. On 30 April 2008 (day 9), leaves of geraniums in the UV supplemented treatment
were necrotic and falling off and whole plants were senescing. Edema of ivy geranium leaves

was occurring despite the supplementation of UVB light.

Summer 2008 Geranium UVB Experiment

Lights in the UV apparatus were raised to 49 cm above the bench surface to prevent
sunburn of leaves. The same three cultivars of ivy geranium were used as in the Spring 2009
geranium UVB experiment were used in this experiment. This experiment began 13 May 2008
(day 1) when the plants were placed in the UV apparatus. Sunburn began three days later (day 4,
16 May 2008) when leaves of plants in the UV-supplemented treatment began turning brown. By
day 8, most of the plants in the UV-supplemented treatment were necrotic, if not fully senescent
and the experiment was terminated. Again, despite the UV-supplementation, all leaves tracked in
this experiment had similar amounts of edema damage. The faster occurrence of sunburn on this
crop may be due to ambient levels of UV-light in the greenhouse being higher as a result of the

season.

Summer 2008 Tomato UVB Experiment |
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A trial experiment looking at the effect of UVB on tomato intumescence development
was attempted. Two cultivars of tomato (Solanum lycopersium L.), ‘Maxifort’ (var. hirsutum)
and ‘Florida-47’ (var. esculentum), were placed in the UV-apparatus with the same dimensions
as the Summer 2008 geranium experiment. The experiment started 30 June 2008 (day 1). On day
3, the tomato plants in the UV-supplemented treatment began turning brown because of sunburn.
By day 4, the plants in the UV-supplemented treatment were necrotic and senescing and the

experiment was terminated.

Summer 2008 Tomato UVB Experiment |1

Concurrently with Summer 2008 tomato experiment 1, a study of possible ways to
prevent sunburn of plants was attempted. In this experiment, the UVB-emitting lights were
raised to 87.6 cm above the bench surface and plastic light diffusers were placed over half the
UV-apparatus; so the diffusers covered one half of the plants in the UV-supplemented treatment
and one half of those in the UV-blocked treatment. Over the other half, plastic film without UV-
absorbing properties was placed between the lights and the tops of the plants.

Plants in the UV-supplemented treatment with the light diffusers and those in the UV-
blocked treatment did not show signs of sunburn throughout the experiment with the termination
of the experiment on 18 July 2008. Plants in the UV-supplemented treatment with the plastic
film without UV-absorbing properties between them and the UVB-emitting lights began turning
brown on day 12 of the experiment and were necrotic and senescing by the termination of the

experiment.

Fall 2008 Tomato UVB Experiment
In this experiment, lights in both UV-apparatuses were raised to 87.6 cm above the bench
surface and the plastic light diffusers were placed between the plants and the UVB-emitting
lights in all treatments. This preliminary study began on 26 August 2008 and included the tomato
cultivars ‘Maxifort’ and ‘Trust.” By 7 November 2008, ‘Maxifort’ plants in the UV-blocked
treatment had intumescences on their leaves (‘Trust’ was resistant to intumescence
development), while plants in the UV-supplemented treatment showed no signs of intumescence

development or sunburn. This preliminary study was terminated on 14 November 2008.
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The diffusers proved to be vital to this experiment. It is our thought that the UV-emitting
lights were providing UVB light at too direct of an angle to the plant surfaces. The use of the
diffusers diffused this light, enabling it to pass through, but hitting the plant surfaces at an angle
the plant could withstand, acting almost as if the ozone layer to the sun’s rays would in the wild.
This set-up is what the Spring 2009 tomato UVB experiment used, as explained in Chapter 2 of

this thesis.
This system was also what was used in run C in the Summer of 2009. However, due to

degradation of our plastic diffusers and the age of the UVB lights, the UV system was no longer
effective in preventing intumescence development. As a result, similar levels of intumescence
development were seen between those in the UV-blocked and UV-supplemented experiments.

Data from this experiment has been included in Appendix D (Table D.3).
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Appendix D - Raw Data All Tomato Experiments

Tomato Root Medium Water Content Spring 2008

Table D.1 Raw data from the Spring 2008 root medium water content experiment. Cultivars
included ‘Maxifort’ (M) and ‘Florida-47’ (F). There were four replications of two water content
treatments, dry (D) and wet (W). Data collected included percent foliage damaged determined
using visual analysis, plant heights (cm), fruit number, fruit weight (g), total fresh weight (g),
total dry weight (g) and tissue calcium levels.

Water % Plant Fruit Fruit Total Total ug/g Ca Ca

Cultivar Status Rep Damage Height # Wt (g) FWt(g) Dry Wt (g) Uptake

M D 1 0.25 158| 15 3 470 68.01] 12036 818568.36
M D 2 0.2 165| 17 6 456 63.8] 15743| 1004403.4
M D 3 0.25 161 8 0.5 588 82.46] 14448| 1191382.08
M D 4 0.4 129 0 0 462 60.61| 16281 986791.41
M W 1 0.5 180 0 0 517 35.06] 20661| 724374.66
M W 2 0.35 197 13 7 1100 155.13| 22342| 3465914.46
M W 3 0.4 197 5 1 955 104.27| 18221| 1899903.67
M W 4 0.5 127 0 0 307 36.45 8412 306617.4
F D 1 0.01 45| 10 355 352 37.37] 23363| 873075.31
F D 2 0.01 771 20 320 493 56.34] 18324| 1032374.16
F D 3 0.02 67| 18| 457 337 42.21| 22763 960826.23
F D 4 0.01 59| 13 288 428 51.5| 28769| 1481603.5
F w 1 0.01 61| 27| 1181 725 76.57| 20556 1573972.92
F W 2 0.03 71| 10 605 566 53.01] 28353| 1502992.53
F w 3 0.01 47| 14| 570 535 55.05|] 23171| 1275563.55
F W 4 0.01 81| 16| 492 457 40.25].
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Tomato UVB Experiment Spring 2009 Raw Data

Table D.2 Raw data from the termination of the Spring 2009 tomato UVB experiment. Two cultivars, ‘Maxifort’ (M) and ‘Trust’ (T)

in two UV treatments with four replications in each of two runs. Growth data included height, fresh weight, dry weight and total leaf

and leaflet numbers. Intumescence data included total number of leaves affected per plant and total number of leaflets affected per

plant.

Fresh |Fresh Total # Lfs Lfs Lflts Lflts
Height |Height |Height |Fresh [Wt Wt Dry Wt |Dry Wt |of Tot Leaf |Tot Leaf |Total # |Tot Lflt |Tot Lflt |#Leaves |Affected |Affect |[# Leaflets |Affected |Affected

CV. |uV Run|Rep [(cm) AVE STDEV |Wt (g) |AVE STDEV |Dry Wt|AVE STDEV |Leaves |AVE STDEV |Leaflets |AVE STDEV |Affected |AVE STDEV |Affected |AVE STDEV
M NoUV |A 1 66 67.5] 7.3258 156 154| 7.1647| 16.88] 16.158] 3.799 13 13.25] 0.95743 165| 162.75] 9.7425 8 8.5] 2.0817 54 49| 14.8997
M NoUV A 2 75 161 16.81 14 172 11 60

M NoUV |A 3 58 155 20.02 14 165 9 55

M NoUV A 4 71 144 10.92 12 149 6 27

M NoUV B 1 24 59| 25.443 166| 158.5| 16.299| 16.35| 16.878] 1.6374 13 14| 1.1547 184 176| 17.493 9 8| 1.8257 28 30| 6.68331
M NoUV B 2 63 151 19.24 15 178 6 23

M NoUV B 3 85 177 16.46 15 191 10 39

M NoUV B 4 64 140 15.46 13 151 7 30

M uv A 1 59| 64.75] 4.9244 136| 137.5] 9.1469| 17.24] 15.243| 3.7815 13 11.5] 1.29099 158 153| 7.3937 1 1.25| 1.2583 1 2.5] 2.38048
M uv A 2 71 126 10.5 10 144 0 9]

M uv A 3 64 140 14.1 11 160 3 5

M uv A 4 65 148 19.13 12 150 1 4

M uv B 1 73 70| 6.6833 159| 170.8] 9.6047| 16.18] 18.41] 2.7569 12 14| 1.41421 162 184| 15.427 3 1.75] 0.9574 12 4.75] 4.99166
M uv B 2 64 167 20.79 15 189 2 4

M uv B 3 78 180 15.87 15 187 1 1

M uv B 4 65 177 20.8 14 198 1 2

T NoUV |A 1 48 51| 4.761 145| 140.8] 16.112| 13.37 14.1] 1.1117 11 11.5] 0.57735 127 127| 8.2865 0 0 0 0 0 0
T NoUV A 2 54 144 15.07 11 116 0 0

T NoUV A 3 56 156 15.03 12 129 9] 0

T NoUV |A 4 46 118 12.93 12 136 9] 0

T NoUV B 1 57 54.5 5 127 133 26.242| 10.18]| 11.175] 2.8947 9 10| 1.82574 127| 120.25| 19.822 0 0 0 0 0] 0
T NoUV B 2 57 143 9.61 11 135 0 9]

T NoUV B 3 47 162 15.49 12 128 0 0

T NoUV B 4 57 100 9.42 8 91 0 0

T uv A 1 39| 47.75] 5.909 151] 140.8] 29.341 15.2] 13.388] 3.4354 11 11| 0.8165 133 115| 20.801 0 0] 0] 9] 0 0
T uv A 2 50 108 8.75 10 96 0 0

T uv A 3 52 128 12.98 11 98 0 9]

T uv A 4 50 176 16.62 12 133 0 0

T uv B 1 53 55| 1.8257 176 173] 5.2915| 19.49] 16.733] 2.1975 12 11.5 1 152 139 22.106 0 0 0 0 9] 0
T uv B 2 56 166 14.84 12 147 0 9]

T uv B 3 57 178 17.51 12 151 0 0

T uv B 4 54 172 15.09 10 106 0 9]
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Table D.3 Raw data taken at the termination of the Summer 2009 UVB experiment “run C.” Two cultivars, ‘Maxifort’ (M) and

Tomato UVB Experiment Summer 2009 Raw Data

“Trust’ (T) in two UV treatments with four replications. Growth data included heights, fresh weights, dry weights, total number of

leaves per plant and total number of leaflets per plant. Intumescence data includes total leaves affected per plant and total leaflets

affected per plant.

Fresh |Fresh |Dry Total Total |Total Lfs Lflts

Height |Height [Height [Fresh |Wt Wt Wt [Dry Wt |Dry Wt |Total [Lfs |Total Lfs |Total |Lflts [Lflts Lfs Aff  |Lfs Aff |Lflts Aff  |Lflits Aff
Cult JuVv Run|Rep [(cm) |AVE [STDEV |Wt(g)|AVE |STDEV |[(g) |AVE |STDEV |Lf# |AVE |STDEV |Lflts |AVE |STDEV|Affected |AVE |STDEV |Affected |AVE |STDEV
M NoUV |C 1 60| 60.5] 4.5092 10 66| 38.288| 9.44| 9.565| 2.1038| 11| 11.5| 1.290994 172| 187.5| 15.438 10| 9.75| 1.2583 117| 135 18.44813
M NoUV |C 2 66 73 7.17 10 178 8 123
M NoUV |C 3 61 88 9.35 13 194 11 140
M NoUV |C 4 55 93 12.3 12 206 10 158
M uv C 1 69| 74.75] 5.058] 131]| 128.3| 12.093| 12.1f 12.555| 0.6191| 13 12] 0.816497 206| 199.3] 7.2744 8| 7.25| 0.9574 95| 102] 15.02221
M uv C 2 73 114 13.3 11 204 8 124
M uv C 3 76 143 12 12 190 6 93
M uv C 4 81 125 12.8 12 197 7 94
T NoUV |C 1 68| 72.25| 4.6458] 203| 180| 39.48| 24.3]19.343| 4.1998| 17| 16.3 0.5 196| 179.3| 11.758 0 0 0 0 0 0
T NoUV |C 2 74 201 20.3 16 178 0 0
T NoUV |C 3 78 195 18.6 16 169 0 0
T NoUV |C 4 69 121 14.2 16 174 0 0
T uv C 1 75| 73.5| 1.7321] 190| 185.3| 7.8049| 17.4| 19.275] 2.9449| 18| 17.5 1 191| 183.8] 10.243 0 0 0 0 0 0
T uv C 2 71 186 20.6 18 193 0 0
T uv C 3 74 191 22.8 18 180 0 0
T uv C 4 74 174 16.4 16 171 0 0
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Tomato UVB Experiment Spring 2009 UV Meter Raw Data
Table D.4 Raw UV-meter data from two instruments, one from Spectrum (Field Scout 3414 Ultraviolet Light Meter; Spectrum
Technologies Inc., Plainfield, IL), the other from Mannix (Mannix UV-340 UV Light Meter; General Tools and Instruments Co. New
York, NY). Readings were taken over the course of the Spring 2009 Tomato UVB experiment.

Spectum  Units: pmol-m™s™

21-Jan 30-Jan 6-Feb 16-Feb 20-Feb 27-Feb 3-Mar 13-Mar 20-Mar 26-Mar

No UV 1 4.975 11.125 5.775 9.9 13.65 6.725 8.975 9 1.175 5.275
uvil 11.8 20.15 13.4 15.55 34.1 15.75 22.925 14.275 3.25 12.075
No UV 2 7.55 18.475 8.1 17.7 21.65 10.15 11.95 7.575 1.2 5.725
uv 2 20.425 41.8 21.925 32.3 21.65 24.8 22.675 14.925 4.65 11.475
Ambient |. . . . . . 23.8 37.875 11.9 37.6

Mannix Units: uW/cm2

21-Jan 30-Jan 6-Feb 16-Feb 20-Feb 27-Feb 3-Mar 13-Mar 20-Mar 26-Mar

No UV 1 142.5 123.75 148.75 289.75 384.25 205.5 275.5 194.25 76.5 235.25
uvi 304 238.5 277 389 613.25 356.5 498 327 134 363.25
No UV 2 200.75 106.5 182.25 345.75 479 262.25 364.75 211 71.5 232.75
uv 2 404.5 276.25 415 572 713.5 481.25 599.75 332.5 158.75 361.5
Ambient |. . . . . . 335 528.75 258 732
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